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1 Analysis and Interpretation of DNA Results 
 
Autosomal Analysis and Interpretation Guidelines 
The AmpFlSTR® Identifiler® Plus PCR Amplification Kits are short tandem repeat (STR) multiplex assays 
that amplify 15 tetranucleotide repeat loci and the Amelogenin gender determining marker in a single 
PCR amplification.  The AmpFlSTR® Identifiler® Plus PCR Amplification Kit uses the same primer 
sequences as the earlier generation AmpFlSTR® Identifiler® PCR Amplification Kit.  The Identifiler® Plus kit 
uses modified PCR cycling conditions for enhanced sensitivity, a new buffer formulation to improve 
performance with inhibited samples, and an improved process for DNA synthesis and purification of the 
amplification primers to deliver a much cleaner electrophoretic background.  With these modifications, 
the AmpFISTR® Identifiler® Plus PCR Amplification Kit delivers the same power of discrimination as, 
better sensitivity than, and better robustness than the earlier generation of the AmpFISTR Identifiler® 
Kit. The AmpFISTR Identifiler® Plus kit employs the latest improvements in primer synthesis and 
purification techniques to minimize the presence of dye-labeled artifacts. These improvements result in 
a much cleaner electropherogram background that enhances the assay’s signal-to-noise ratio and 
simplifies the interpretation of results.  
 

Loci Targeted by AmpFlSTR® Identifiler® Plus PCR Amplification Kits

 
 



      Biology/DNA  
DNA Interpretation SOP 

Biology/DNA Division 
  
 

 
DNA Interpretation SOP Document ID: 25414 
Issued By: Section Technical Leader  Issue Date: September 10, 2018 
Uncontrolled When Printed Page 4 of 61 
 

The GlobalFiler amplification kit is a multiplex PCR assay that amplifies 24 loci in a single amplification 
reaction.  The kit exceeds the new CODIS core loci requirements.  GlobalFiler contains all 20 current core 
CODIS loci, Amelogenin, a Y-STR marker (DYS391), a novel Y Indel, and SE33.  The increase in the number 
of loci will provide higher discrimination power, stronger kinship analysis, and increased international 
database compatibility.  Furthermore, the addition of 10 mini-STR loci that are less than 220 base pairs 
(bp) in size maximizes the kits performance with degraded samples. 
 
The addition of the DYS391 locus and the Y Indel marker is advantageous for sex determination 
confirmation.  With the addition of the Y Indel marker, Life Technologies added an additional sex 
determination marker.  An Indel is an Insertion or Deletion of a short sequence of nucleotides.  The Y 
Indel amplicon in the GlobalFiler kit is less than 90 bp.  A ‘1’ allele indicates the deletion and a ‘2’ allele 
indicates the insertion.  The Y Indel marker is beneficial when the Amelogenin Y allele in a male sample 
is null and the DYS391 marker (361-393 bp) drops out, either due to mutation, degraded DNA or low 
template DNA.   
Loci Targeted by GlobalFiler PCR Amplification Kit  
Locus 

Designation 
Chromosome 

Location Alleles Included in Allelic Ladder* Dye 
Label 

DNA 
Control 007 

D3S1358 3p21.31 8, 9, 10, 11, 12, 13, 14, 15, 15.2, 16, 16.2, 17, 17.1, 17.2, 18, 18.2, 19, 
20, 20.1 

6-
FAM™ 15,16 

vWA 12p13.31 10, 11, 12, 13, 14, 15, 15.2, 16, 17, 18, 18.2, 19, 20, 21, 22, 23, 24, 25  14, 16 
D16S539 16q24.1 4, 5, 6, 7, 8, 8.3, 9, 9.3, 10, 11, 11.3, 12, 12.1, 12.2, 13, 13.3, 14, 15  9, 10 

CSF1PO 5q33.3-43 5, 6, 7, 7.3, 8, 8.1, 9, 9.1, 10, 10.1, 10.2, 10.3, 11, 11.1, 11.3, 12, 12.1, 
12.3, 13, 14, 15  11, 12 

TPOX 2p23-2per 4, 5, 6, 7, 7.1, 7.3, 8, 9, 10, 10.1, 10.3, 11, 12, 13, 14, 15, 16  8, 8 
Y indel Yq11.221 1, 2 VIC® 2 

Amel X: p22.1-22.3 
Y: p11.2 X, Y  X, Y 

D8S1179 8q24.13 4, 5, 6, 7, 8, 9, 10, 10.2, 11, 12, 12.3, 13, 13.3, 14, 15, 15.3, 16, 17, 18, 
19, 20  12, 13 

D21S11 21q11.2-q21 

23.2, 24, 24.2, 25, 25.2, 25.3, 26, 26.2, 27, 27.1, 27.2, 28, 28.1, 28.2, 
28.3, 29, 29.1, 29.2, 29.3, 30, 30.1, 30.2, 30.3, 31, 31.1, 31.2, 31.3, 32, 
32.1, 32.2, 32.3, 33, 33.1, 33.2, 33.3, 34, 34.1, 34.2, 35, 35.1, 35.2, 36, 
36.1, 36.2, 37, 37.2, 38, 38.2, 39 

 28, 31 

D18S51 18q21.33 
6, 7, 8, 9, 9.2, 10, 10.2, 11, 11.2, 12, 12.2, 12.3, 13, 13.1, 13.2, 13.3, 14, 
14.2, 15, 15.2, 15.3, 16, 16.1, 16.2, 17, 17.2, 17.3, 18, 18.1, 18.2, 19, 
19.2, 20, 20.2, 21, 21.1, 22, 22.2, 23, 23.2, 24, 25, 26, 27, 28 

 12, 15 

DYS391 Yq11.21 6, 7, 8, 9, 10, 11, 12, 13, 14  11 
D2S441 2p14 8, 9, 9.1, 10, 11, 11.3, 12, 12.3, 13, 13.3, 14, 14.3, 15, 16, 17 NED™ 14, 15 

D19S433 19q12 5.2, 6, 6.2, 7, 8, 9, 9.2, 10, 10.2, 11, 11.2, 12, 12.1, 12.2, 13, 13.1, 13.2, 
14, 14.2, 14.3, 15, 15.2, 16, 16.2, 17, 17.2, 18, 18.2, 18.2, 19  14, 15 

TH01 11p15.5 3, 4, 5, 5.3, 6, 6.3, 7, 7.3, 8, 8.3, 9, 9.3, 10, 10.3, 11, 12, 13, 13.3  7, 9.3 

FGA 4q28 

12.2, 13, 14, 15, 16, 16.1, 16.2, 17, 17.2, 18, 18.2, 19, 19.2, 19.3, 20, 
20.1, 20.2, 20.3, 21, 21.2, 21.3, 22, 22.1, 22.2, 22.3, 23, 23.1, 23.2, 
23.3, 24, 24.1, 24.2, 24.3, 25, 25.1, 25.2, 25.3, 26, 26.1, 26.2, 27, 27.2, 
28, 28.2, 29, 29.2, 30, 30.2, 31, 31.2, 32, 32.2, 33.2, 34.2, 41.2, 42.2, 
43.2, 44.2, 45.2, 46.2, 47.2, 48.2, 49.2, 50.2, 51.2 

 24, 26 

D22S1045 22q12.3 7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20 TAZ™ 11, 16 
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D5S818 5q21-31 6, 7, 8, 9, 10, 10.1, 11, 11.1, 12, 12.1, 12.3, 13, 14, 15, 16, 19  11, 11 
D13S317 13q22-31 5, 6, 7, 7.1, 8, 8.1, 9, 10, 11, 11.3, 12, 12.3, 13, 13.3, 14, 15, 16, 17  11, 11 

D7S820 7q11.21-22 5, 5.2, 6, 6.3, 7, 7.1, 7.3, 8, 8.1, 8.2, 8.3, 9, 9.1, 9.2, 9.3, 10, 10.1, 10.3, 
11, 11.1, 11.3, 12, 12.1, 12.3, 13, 13.1, 14, 14.1, 15, 16  7, 12 

SE33 6q14 

4.2, 5, 6, 6.3,7, 8, 8.2, 9, 9.2, 10, 10.2, 11, 11.2, 12, 12.2, 13, 13.2, 14, 
14.2, 14.3, 15, 15.2, 15.3, 16, 16.2, 16.3, 17, 17.2, 18, 18.2, 19, 19.2, 
19.3, 20, 20.2, 21, 21.1, 21.2, 22, 22.2, 23, 23.2, 24, 24.2, 28, 25.2, 26, 
26.2, 27, 27.2, 28, 28.2, 29, 29.2, 30, 30.2, 31, 31.2, 32, 32.2, 33, 33.2, 
34, 34.2, 35, 35.2, 36, 36.2, 37, 37.2, 38 

 17, 25.2 

D10S1248 10q26.3 7, 8, 9, 10 ,11, 12, 13, 14, 15, 16, 17, 18, 19 SID™ 12, 15 

D1S1656 1q42.2 8, 9, 10, 11, 12, 13, 13.3, 14, 14.3, 15, 15.3, 16, 16.3, 17, 17.1, 17.3, 18, 
18.3, 19, 19.3, 20, 20.3, 21  13, 16 

D12S391 12p13.2 13, 14, 15, 16, 17, 17.1, 17.3, 18, 18.1, 18.3, 19, 19.1, 19.3, 20, 20.1, 
20.3, 21, 22, 23, 24, 24.3, 25, 26, 27  18, 19 

D2S1338 2q35 10, 11, 12, 13, 14, 15, 16, 17, 18, 18.3, 19, 19.3, 20, 21, 22, 23, 23.2, 
23.3, 24, 24.2, 25, 26, 27, 28, 29  20, 23 

*Green font indicates virtual bins. 
 
Loci Layout for GlobalFiler 

 
1.1 Analysis 

1.1.1 GeneMapper Analysis 
1.1.1.1 Allele assignment occurs through a three-step process:  

• Spectral separation:  The 4 dyes that Identifiler Plus uses in the STR amplification are 6-FAM, 
VIC, NED, and PET.  A fifth dye, LIZ, is used in the internal size standard.  The 5 dyes that 
GlobalFiler and Yfiler Plus use are 6-FAM, VIC, NED, TAZ, and SID.  The sixth dye, LIZ, is used in 
the internal size standard.  Although each dye emits its maximum fluorescence at a different 
wavelength, there is overlap in the emission spectra.  Multi-component analysis is the process 
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that separates the five or six different fluorescent dye colors into distinct spectral components.  
This analysis occurs automatically after each instrument run.  

• Note: The precise spectral overlap is determined by separately analyzing DNA fragments labeled 
with each of the dyes (spectral standards). 

• Peak BP sizing:  The internal size standard (GS500 LIZ, for the Identifiler Plus and Yfiler multiplexes 
and GS600 LIZ for the GlobalFiler and Yfiler Plus multiplexes) is used to calculate precise peak bp 
sizing. The internal size standard is used to normalize injection-to-injection variations.  The Local 
Southern method is used to compare allele peaks with the LIZ peaks and calculate the bp size.  
This method uses the two points in the size standard directly below (smaller than) and the one 
point directly above (larger than) the unknown fragment and then one point below and two 
above.  The average of those calculations is then used to determine the size of the unknown 
fragment.  In GlobalFiler, there are 2 instances where a deviation from the Local Southern method 
will be utilized.  The ‘8’ bin in the D2S441 locus in the yellow dye is smaller than 80 bp, leaving 
only one fragment in the size standard (60 bp) less than the shortest peak in the allelic ladder.  
Likewise, the virtual bins ’37.2’ and ‘38’ in the SE33 marker are larger than the 440 bp leaving only 
one fragment in the size standard (460 bp) larger than these possible alleles.  In these instances, 
the algorithm will use the two closest points to the unknown peak to determine the fragment 
length.  Life Technologies performed the developmental validation of the GlobalFiler kit using this 
method and did not see any issues with sizing.   

• Allele designations:  Allele calls for each peak are made by comparing the bp size of the sample 
or control peak to the bp sizes of peaks in the allelic ladder. Thus for allele designations to be 
determined, an allelic ladder must be present and interpretable in each run, and each ladder 
must have the appropriate alleles present for each locus when analyzed. 

 
1.1.2 GeneMapper Procedure 

1.1.2.1 Login to GeneMapper using the appropriate username and password. 
1.1.2.2 Add Samples to Project:  Browse to appropriate data folders.  Select the Casework 

folder and click Add To List at the bottom of the screen. Click Add to import the files 
into the project and close the dialog box.  The samples are displayed in the Project 
window. 

1.1.2.3 Check that the Sample Type, Analysis Method, Panel, and Size Standard are 
correctly labeled.   

 For Identifiler Plus:  
• Sample types: Select the sample type; allelic ladder samples must be labeled as “Allelic 

Ladder” 
• Analysis method: Identifiler_Plus_AnalysisMethod_v1X 

o Verify the analysis range is set to exclude the primer peak 
o Verify the minimum peak threshold is 50 RFU 

• Panel: Identifiler_Plus_Panels_v1.2X 
• Size standard: CE_G5_HID_GS500  

 
  For GlobalFiler:  
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• Sample types: Select the sample type; allelic ladder samples must be labeled as “Allelic 
Ladder” 

• Analysis method: GlobalFilerAT 
o Verify the analysis range is set to exclude the primer peak 
o Verify the minimum peak thresholds are: 

 
 

 
 
 
 

 
 
• If multiple peaks not readily attributable to artifact are observed below the analytical 

threshold in a reagent blank or amplification negative control, the sample should be 
analyzed using the peak detection threshold, GlobalFilerPD, to investigate the possibility of 
contamination.  Consult the DNA Technical Leader, the Forensic Biology Manager, or the 
DNA Interpretation Supervisor when activity in a reagent blank or amplification negative 
control is detected between the peak detection threshold and the analytical threshold. 

o Verify the analysis range is set to exclude the primer peak 
o Verify the minimum peak thresholds are: 

Dye Color Minimum Peak Detection Threshold 
(RFU) 

Blue 35 
Green 30 
Yellow 30 

Red 30 
Purple 30 

 
• Panel: GlobalFiler_v1 
• Size standard: GS600_LIZ_(60-460)  

 
1.1.2.3.1 Analysis settings are GeneMapper Default settings unless otherwise 

documented in this SOP.   
1.1.2.3.2 Hit the green arrow on the toolbar.   

• Project files shall be uniquely named, such as with the initials and the date the run was set up.  
For example, a run on May 19, 2009 by JD should be named JD051909.  Multiple runs on the 
same day can be put into sequential order utilizing either numbers or letters (e.g. JD051909, 
JD051909B, PA051909, and PA051909#2).  Alternatively, the LIMS-generated 3130 plate number 
may be used to identify the GeneMapper project. 

 
1.1.2.3.3 Checking Internal Lane Size Standards (ILS):  

Dye Color Minimum Analytical Threshold 
(RFU) 

Blue 80 
Green 60 
Yellow 70 

Red 60 
Purple 60 
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• The use of an internal lane size standard is essential for achieving high precision for sizing DNA 
fragments by electrophoresis. Without correct ILS calls, sample profiles may be inaccurate. Each 
peak for an ILS as described below needs to be called in order for a sample to be analyzed. If one 
is not called the GeneMapper software flags it as a size standard failure.  

• Visually inspect each ILS peak within each sample to ensure it is labeled correctly. Examine 
peaks for good morphology and similar RFU heights.  If the ILS exhibits poor morphology or 
dissimilar RFU heights, the sample should be re-injected when there is a possibility of the failure 
to detect allelic data. It may not be necessary to re-inject full, single-source samples for which 
there is no reasonable expectation that data may be undetected due to a poor injection, such as 
in a positive control or reference sample.  Evidence will generally not qualify for this exception, 
since we have no expectation of results on items of evidence.  LIZ includes peaks at the 
following base pair sizes:   

o Identifiler Plus: GeneScan™ 500 (GS-500 (LIZ)): 75, 100, 139, 150, 160, 200, floater (245-
250), 300, 340, 350, 400, and 450 bps.   

 
Example of an acceptable Identifiler Plus ILS: 

 
 
Example of an unacceptable Identifiler Plus ILS: 

 
o GlobalFiler: GeneScan™ 600 (GS-600 (LIZ)): 60, 80, 100, 114, 120, 140, 160, 180, 200, 214, 

220, 240, 250, 260, 280, 300, 314, 320, 340, 360, 380, 400, 414, 420, 440, and 460 bps.   
 

Example of an acceptable GlobalFiler ILS: 
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Example of an unacceptable GlobalFiler ILS: 

 
NOTE: With GS-500(LIZ), the 250 size standard fragment forms a secondary structure while migrating 
through polymer that causes the fragment to not migrate as a 250 bp fragment should. Therefore, it is 
standard to not label the 250 bp fragment. The GS-600 (LIZ) 250 size standard does not form a 
secondary structure while migrating through polymer. 
 

• If a sample results in a size standard failure, the analysis starting and stopping point may be 
adjusted under the corresponding Analysis Method in GeneMapper™ IDX to account for changes 
in migration rates. If this does not address the size standard failure, the sample may need to be 
re-injected onto the analyzer to address the failure. If this measure does not fix the issue the 
sample can be prepared again and added onto a genetic analyzer. Consult the DNA Technical 
Leader, the Forensic Biology Manager, or the DNA Interpretation Supervisor if the 
aforementioned measures are unsuccessful.  

 
NOTE: Changes to starting and stopping points in an Analysis Method in GeneMapper™ IDX changes 
these values for all users. 
 

1.1.2.3.4 Examine ladders and all controls and confirm: 
• Allelic ladders were correctly labeled.  GeneMapper averages all injections labeled “Allelic 

Ladder” for the same panel.  If any ladders do not exhibit quality data, change the sample type 
from “Allelic Ladder” to “Sample” so they are not included in the software averaging of ladders. 

• All positive control peaks are present and labeled correctly.  No extra peaks indicating 
contamination are present.  If the amplification positive control fails to amplify/type correctly, 
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all associated samples must be re-amplified.  The positive control can be re-injected prior to re-
amplification to verify if the issue is PCR-based or related to the capillary electrophoresis set-up 
or injection. 

• All negative controls (reagent blanks and amplification negative control) show no labeled peaks 
indicating contamination.  Refer to the General DNA SOP for guidance if activity is detected in a 
negative control.  Each reagent blank must have acceptable results for data from the 
corresponding extraction set to be used.  The amplification negative control must have 
acceptable results for data from the corresponding amplification set to be used.  Additionally, 
each analyzer run must have at least one acceptable negative control.   

 
1.1.2.3.5 Examine all electropherograms for data quality and allele calls.  Refer to the 

discussion below for guidance on evaluating data and editing artifacts and 
microvariant calls.  

• It is acceptable to delete/rename artifacts within the GeneMapper project.  
• Right click on the peak or allele to be edited.  Choose either to Delete Allele or Rename 

Allele.  After making selection, a dialog box appears asking for a sample comment.  You 
must type in an explanation of the edit.  

• Deleting an allele marks it through with a cross out and allows it to be removed from the 
plot (i.e. pull up).  Renaming an allele leaves the allele but allows for the call to be 
changed (i.e. microvariant).   

• GeneMapper tracks changes.  When the “track changes” option is on, all alleles, including 
deleted ones, are displayed.  When “track changes” is turned off, only alleles that have not been 
deleted are displayed, including those that are renamed. 

• When plots are printed with the “track changes” turned off, the “Label Edit Viewer” entries 
must be printed.  The project must be saved before the table is populated with the latest 
changes. 

• To print the “Label Edit Viewer”, first save the project. 
• Select all samples in the Samples tab 
• Go to View -> Label Edit Viewer 
• Select export and save the file 
• Open the file in excel and print 
• The table must be labeled with the project name and the date printed 
• This table must be initialed by both the writing analyst and the technical reviewer. 

• It is important to understand that when a sample is analyzed, all prior changes are overwritten 
and returned to the original state.  Re-analyze samples only if absolutely necessary and limit to 
only those samples necessary.   

 
1.1.2.3.6 Upon completion of analysis, save the project.  Print plots for all case 

samples and associated controls to be included in the case file.  Place in 
each case folder a printout of the complete GeneMapper project list for 
each run and the electropherograms (all 5 or 6 colors) for the positive 
control, negative control, and all samples and reagent blanks for that case.  
If an entire run is not used, it is not necessary to print the plots. However, 
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the injection list must be included in the case file with an explanation as to 
why data was not used (e.g., no acceptable positive control).  Document 
each time injection parameters change, such as longer or shorter injection 
times.   

1.1.2.3.6.1 Electropherograms shall be marked with the following for all 
interpretable mixtures: 
• Any major/minor/trace distinctions 
• The minimum number of contributors or the finite number of 

contributors, if applicable 
• Any assumptions made in the interpretation of the data, such as 

the assumed contributor 
• Any deductions made using an assumed contributor 

 
Legend for Analyst’s Electropherogram Notes 

** May be attributed to elevated stutter 
 Minor alleles (circled) 

[ ] Trace alleles 
-- Allelic drop out or masking may be possible 

AC Assumed contributor 
EF Epithelial Fraction 

INC Inconclusive 
ND No Deduction 
NR No Results 
SF Sperm Fraction 

 
1.1.2.3.6.2 When STR data for an extraction is not used for interpretation due to 

quality control issues, the case files must include, at a minimum, all 
associated examination documentation and a capillary 
electrophoresis grid for each injection.  

 
1.1.2.3.7 A second analyst must review the GeneMapper project independently and 

agree with the allele calls reported by the first analyst.  The second analyst’s 
initials and date on the injection list indicate a GeneMapper project review 
of the associated controls and samples within a case. 

 
1.1.2.3.8 In order to import GeneMapper allele calls into the allele chart of LIMS 

reports:  
• Select the case-specific samples to be exported in the sample tab (this must be 
performed for each case) 
• Go to Tools -> Report Manager 
• Ensure that LIMS Import Report is selected 
• Go to File -> Export 
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• Save the file  
• Go to the allele chart panel in LIMS -> Import  
• Navigate to location of your saved GeneMapper export file->Open  
• Select Replace->OK to replace existing data or 
• Select Append->OK to add to existing table data 
 

1.1.2.3.9 Allele calls may also be manually entered into the LIMS allele chart panel. 
 

1.1.3 Artifacts and unusual results 
1.1.3.1 True alleles are defined as any peak that meets established threshold values, which 

is clearly visible above baseline noise, is of a size that falls within a defined category 
as determined by the GeneMapper program, and is not an artifact.  Peaks other 
than true alleles may be detected on the electropherogram and labeled by 
GeneMapper.  The source of these artifacts should be determined where possible.  
If such a peak can be definitely identified as an artifact and the peak does not 
interfere with interpretation of the data, then the artifact can be described 
appropriately and the data can be used for interpretation.  The presence of the 
artifact shall be documented on the plot or the Label Edit Viewer table.  A technical 
reviewer must agree with the analyst’s decision and shall initial the plot to indicate 
his/her agreement or the Label Edit Viewer. Disagreements between the analyst and 
technical reviewer must be brought to the DNA Technical Leader, the Forensic 
Biology Manager, or the DNA Interpretation Supervisor for resolution. If an artifact 
or suspected artifact may interfere with interpretation, the data cannot not be used; 
the locus may be called inconclusive or the sample may be re-analyzed (re-inject or 
re-amplify) to resolve the issue.   

 
It may not always be possible to conclusively attribute labeled activity to either being 
a true peak or an artifact.  For example, in a mixture with minor activity that also 
exhibits spectral failure (or pull-up), a re-injection may not provide conclusive 
evidence that a minor peak that could also be pull-up is artefactual or not.  In those 
instances, it may be most appropriate to label a peak as “inconclusive”.  Loci 
containing “inconclusive” activity shall not be included in statistics.   

 
1.1.3.2 Commonly observed artifacts include: 

1.1.3.2.1 Spikes: Spikes are sharp, narrow peaks generally present in all colors and 
occur at the same location. This is often caused by electrical anomalies. This 
can also be caused by air bubbles and urea crystals.   

 
1.1.3.2.2 Stutter: A stutter peak is a reproducible minor product peak usually four 

bases (1 repeat) shorter than the corresponding main allele peak.  Stutter 
products are the most common source of additional peaks in an STR sample, 
caused by a slipped-strand mispairing during PCR.  Rarely, stutter may be 
observed at two or three repeats shorter that the true allele, or one repeat 
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greater than the true allele. Peaks in the minus 1 repeat position that fall 
below the maximum % stutter values (see the Identifiler Plus and GlobalFiler 
internal validation data) may be assumed to be stutter, and GeneMapper 
does not label these peaks.  If an apparent stutter peak exceeds the 
published maximum stutter percent, the sample must be carefully 
evaluated to determine if the peak may be a true peak or stutter.  In 
general, the percent stutter increases with allele length, specifically the 
uninterrupted sequence length. Forward stutter peaks generally exhibit a 
much lower percentage difference from the true allele than minus one 
repeat stutter peaks.  Both minus 1 repeat and plus 1 repeat stutter seem to 
be more common when excessive template DNA is amplified (when one or 
more of the critical components of the amplification master mix becomes 
limited or depleted, causing a loss of processivity).   

 
The following conditions generally lead to elevated stutter:  

• Using low amounts of amplifiable DNA during PCR amplification causing stochastic effects to 
lead to the increased amount of stutter products relative to the true allele peaks; stutter 
product generated during the early amplification cycles may be subsequently amplified in 
later cycles along with the true allele products, resulting in stutter peak activity that is 
higher than what is routinely observed in validation studies and casework where more 
optimal amounts and quality are amplified in the PCR.  (see 13.1.4 below for corrective 
action) During the stochastics study of the GlobalFiler validation, stutter was observed that 
exceeded the manufacturer’s recommended stutter percentages by over 20%.  Extreme 
caution should be used when examining stochastic data, specifically when attempting to 
determine a finite number of contributors. 

• Loading excessive amounts of amplified DNA onto the genetic analyzer causing a 
phenomenon known as over-subtraction; over-subtraction can cause elevated pull-up, 
stutter and minus A peaks when the analysis software normalizes the true off-scale peak(s) 
but does not adjust the artifacts (because they are not off-scale).  This may also result in a 
loss of linearity in RFU increase when injection times are extended.  (see 13.1.4 below for 
corrective action) 

• Limited or pervasive conditions that affect the production of and amplification of the stutter 
products relative to the true allele template and products, also known as “preferential 
amplification”, even when performed under routine and optimal conditions, that may result 
in an increase in the percentage of the peak height observed for a stutter peak relative to 
the peak height observed for the true allele. 

• For mixtures in which minor contributors are determined to be present, a peak in stutter 
position (generally n-4) may be determined to be 1) a stutter peak, 2) an allelic peak, or 3) 
indistinguishable as being either an allele or stutter peak.  This determination is based 
principally on the height of the peak in the stutter position and its relationship to the stutter 
percentage expectations established by the laboratory.  Generally, when the height of a 
peak in stutter position exceeds the laboratory’s stutter expectation for a given locus, that 
peak is consistent with being of allelic origin and designated as an allele.  If a peak is at or 
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below this expectation, it is generally designated as a stutter peak.  However, it could also 
be considered as a possible allelic peak, particularly if the peak height of the potential 
stutter peak(s) is consistent with (or greater than) the heights observed for any allelic peaks 
that are conclusively attributed (i.e., peaks in non-stutter positions) to the minor 
contributor(s).   

• Caution must be exercised when peaks in stutter position are observed in: 1) samples that 
show no other obvious indications of a second contributor; 2) mixtures from two or more 
contributors where all of the peaks observed are low or mixtures that can be deconvoluted 
into major and minor contributors, but the minor peaks also appear in stutter position; and 
3) samples with peaks observed in the stutter position with calculated stutter percentage 
only a few percentage points (1-5%) higher than the maximum percentage used for 
filtration.  The misidentification of stutter activity as real activity can result in an incorrect 
increase to the number of contributors to a given profile.  Peaks that cannot be conclusively 
attributed to stutter activity over true activity may be reported as “inconclusive”. 

 
AmpFISTR® Identifiler® Plus Kit  

Marker Max Average StdDev Avg + 3 SD GM IDP Panel  HFSC Protocol 
D8S1179 8.74 5.31 1.17 8.82 10.32 10.32 
D21S11 8.68 6.72 0.79 9.08 10.67 10.67 
D7S820 7.10 4.87 1.00 7.88 9.69 9.69 
CSF1PO 6.31 4.49 0.82 6.94 9.20 9.20 
D3S1358 12.80 7.29 1.26 11.07 12.27 12.27 
TH01 3.95 1.79 0.71 3.91 4.08 4.08 
D13S317 8.33 4.01 1.35 8.06 9.93 9.93 
D16S539 13.88 5.70 1.99 11.67 10.39 11.67 
D2S1338 12.63 7.15 1.29 11.03 12.44 12.44 
D19S433 8.98 6.55 0.76 8.82 11.21 11.21 
vWA 13.10 7.10 1.28 10.92 12.45 12.45 
TPOX 5.57 2.31 0.82 4.76 6.38 6.38 
D18S51 15.13 8.27 1.78 13.60 13.68 13.68 
D5S818 9.43 5.85 1.28 9.70 10.06 10.06 
FGA 17.65 8.46 2.21 15.09 13.03 15.09 

Bold values indicate higher percentages than developmental validation and therefore require 
adjustment to the GeneMapper Panel Manager. 
 
GlobalFiler Kit  

Marker Stutter 
Position (n) Average Standard 

Deviation 
Max 

Observed 

Average 
+ 3x 

Standard 
Deviation 

Manufacturer 
Recommended 

HFSC 
Protocol 

D3S1358 n-4 63 6.96% 0.98% 8.93% 9.90% 10.98% 10.98% 
vWA n-4 61 5.96% 1.77% 10.05% 11.27% 10.73% 11.27% 
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D16S539 n-4 49 4.82% 1.30% 8.15% 8.72% 9.48% 9.48% 
CSF1PO n-4 54 5.19% 1.19% 10.11% 8.76% 8.77% 8.77% 
TPOX n-4 35 2.73% 0.78% 3.89% 5.07% 5.55% 5.55% 
D8S1179 n-4 72 5.77% 1.44% 9.46% 10.09% 9.60% 10.09% 
D21S11 n-4 69 6.52% 1.07% 8.88% 9.73% 10.45% 10.45% 
D18S51 n-4 72 6.53% 1.71% 12.59% 11.66% 12.42% 12.42% 
DYS391 n-4 14 5.27% 0.91% 7.28% 8.00% 7.43% 8.00% 
D2S441 n-4 74 4.54% 1.10% 6.80% 7.84% 8.10% 8.10% 
D19S433 n-4 66 6.04% 1.22% 9.75% 9.70% 9.97% 9.97% 
TH01 n-4 58 2.05% 0.63% 3.60% 3.94% 4.45% 4.45% 
FGA n-4 82 7.17% 2.16% 19.75% 13.65% 11.55% 13.65% 
D22S1045 n-3 77 6.89% 2.65% 11.89% 14.84% 16.26% 16.26% 
 n+3 54 3.91% 1.15% 7.12% 7.36% 6.69% 7.36% 
D5S818 n-4 63 5.28% 0.95% 8.26% 8.13% 9.16% 9.16% 
D13S317 n-4 62 4.22% 1.59% 7.72% 8.99% 9.19% 9.19% 
D7S820 n-4 61 4.08% 1.47% 9.25% 8.49% 8.32% 8.49% 
SE33 n-4 94 8.67% 1.74% 14.01% 13.89% 14.49% 14.49% 
 n-2 76 3.04% 0.96% 10.54% 5.92% 3.97% 5.92% 
D10S1248 n-4 62 6.80% 1.17% 9.73% 10.31% 11.46% 11.46% 
D1S1656 n-4 76 6.95% 1.82% 14.31% 12.41% 12.21% 12.41% 
 n-2 44 1.46% 0.30% 2.37% 2.36% 2.45% 2.45% 
D12S391 n-4 63 7.23% 2.03% 12.30% 13.32% 13.66% 13.66% 
D2S1338 n-4 81 6.80% 1.66% 12.76% 11.78% 11.73% 11.78% 

Bold values indicate higher percentages than developmental validation and therefore require 
adjustment to the GeneMapper Panel Manager. 
 
GlobalFiler DNA Dependent Stutter Artifacts 

Marker Stutter 
Position (n) Average Standard 

Deviation 
Max 

Observed 

Average + 3x 
Standard 
Deviation 

HFSC 
Protocol 

D3S1358 
n+4 5 0.64% 0.35% 1.25% 1.69% 1.69% 
n-8 3 0.70% 0.23% 0.88% 1.39% 1.39% 

D16S539 n+4 1     0.72%   0.72%  
CSF1PO n+4 4 2.04% 1.79% 4.63% 7.41% 7.41% 

TPOX n+4 1     2.72%   2.72%  

D8S1179 
n+4 17 0.83% 0.38% 1.70% 1.97% 1.97% 
n-8 2 0.38% 0.04% 0.41% 0.50% 0.50% 

D21S11 
n+4 9 0.94% 0.20% 1.31% 1.54% 1.54% 
n-8 7 2.39% 1.70% 5.63% 7.49% 7.49% 

D18S51 n+4 5 1.70% 0.78% 2.77% 4.04% 4.04% 
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n-8 2 2.82% 2.38% 4.50% 9.96% 9.96% 
D2S441 n+4 11 0.84% 0.29% 1.54% 1.71% 1.71% 

D19S433 
n+4 4 1.56% 0.53% 2.03% 3.15% 3.15% 
n-8 1     1.12%   1.12% 

TH01 n-8 1     1.41%   1.41% 

FGA 
n+4 7 0.97% 0.36% 1.64% 2.05% 2.05% 
n-8 2 0.67% 0.30% 0.88% 1.57% 1.57% 

D22S1045 n-6 6 0.64% 0.32% 1.29% 1.60% 1.60% 

D5S818 
n+4 18 0.97% 0.28% 1.71% 1.81% 1.81% 
n-8 5 0.53% 0.06% 0.63% 0.71% 0.71% 

D13S317 
n+4 14 1.06% 0.66% 2.60% 3.04% 3.04% 
n-8 4 0.58% 0.15% 0.75% 1.03% 1.03% 

D7S820 n+4 2 0.38% 0.03% 0.40% 0.47% 0.47% 

SE33 
n+4 21 1.48% 1.34% 6.32% 5.50% 5.50% 
n-6 1     0.39%   0.39%  
n-8 7 0.68% 0.10% 0.83% 0.98% 0.98% 

D10S1248 
n+4 4 1.82% 1.31% 3.13% 5.75% 5.75% 
n-8 5 0.75% 0.47% 1.43% 2.16% 2.16% 

D1S1656 
n+4 16 1.12% 0.61% 3.04% 2.95% 2.95% 
n-8 5 0.59% 0.08% 0.71% 0.83% 0.83% 

D12S391 
n+4 1     1.64%   1.64%  
n-8 2 0.65% 0.19% 0.79% 1.22% 1.22% 

D2S1338 
n+4 1     0.72%   0.72%  
n-8 5 0.62% 0.19% 0.76% 1.19% 1.19% 

 
 

1.1.3.2.3 Incomplete 3’(+A) nucleotide addition/Minus A:   PCR amplification results 
in the addition of a single “A” nucleotide at the 3’ end of double stranded 
PCR products, resulting in a product that is one bp longer than the actual 
target DNA sequence.  PCR reactions have been optimized to favor this “A” 
addition, but incomplete “A” addition may occur when excessive amount of 
target DNA is present, or in other conditions that are less than optimal for 
the PCR reaction.  Incomplete “A” addition, or “minus A” appears as a peak 
one bp shorter, and typically at a smaller peak height than the true allele.  
See the stutter discussion regarding over-subtraction.  

 
1.1.3.2.4 Pull-up/Matrix Failure:   Pull-up is the result of the instrument’s inability to 

completely separate the spectral components.  Pull-up is identified as a 
smaller peak of the same location as a true allele but in another color.  It is 
the result of either excessive DNA or a faulty spectral.  Complex pull-up 
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occurs when a locus is heterozygous and the two peaks are within one 
repeat unit of each other.  This can cause a single bridge-like peak to be 
observed in another color channel.  See the stutter discussion regarding 
over-subtraction.  

 
1.1.3.2.5 Dye Blobs: Dye blobs occur when fluorescent dyes come off their respective 

primers and migrate independently through the capillary.  Dye blob 
morphology is generally characteristically broad, and not very “peak-like”. 

 
1.1.3.2.6 Non-DNA activity that cannot conclusively be attributed to one of the 

previously defined artifacts may be described generally, using terms such as 
“artifact”, “elevated baseline”, or “weak morphology”.   

 
1.1.3.3 Other GlobalFiler artifacts, published or observed during internal validation: 

 
Locus/Loci  Approximate 

size 
Cause Additional information 

Amelogenin 
and Yindel 

~94.5 bp likely caused by 
secondary structure or 
non-STR amplification 
by-product 

Typically observed at ~94.5 bp, at 0.3% to 0.7% of the parent 
peak, and does not fall within an allelic bin. Peak height is 
directly proportional to the peak height of the X allele peak.  
Although the artifact peaks are typically present at low levels, 
they may be observed depending on DNA input amount and 
the peak detection threshold used for analysis. 
 
Source: developmental validation 

D2S1338 ~345 bp Unknown Sequencing revealed no homology with the human genome, 
nor did the NCBI BLAST search yield any significant matches to 
other genomes in the database. 
 
Source:  Thermo Fisher sequencing of HFSC amplicon 

Before 
D2S441 

~63 bp Probable cause is a DNA 
template independent 
artifact likely caused by a 
primer dimer  

Typical signal intensity is relative to the kit storage and usage 
conditions; not always reproducible upon re-amplification; may 
be caused or exaggerated by suboptimal kit storage or usage 
conditions, such as extended bench time at ambient 
temperature during PCR setup 
 
Source: Thermo Fisher Scientific Technical Note dated 
November 29, 2017 

D2S441 ~87 bp likely intrinsic to primer 
design, probably from a 
secondary structure or 2-
base slippage 

Typically observed at ~87 bp, at ~0.5% of the parent peak. 
 
Source: Thermo Fisher database and Thermo Fisher internal 
observations 
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D2S441 ~92-100 bp probable cause is a DNA 
template independent 
artifact likely caused by a 
dye derivative (dye 
amide), which is a 
cleavage of the dye from 
the labeled primer at the 
amide linkage 

Typical signal intensity is <175 RFU; may be promoted by post-
manufacturing activities, such as repeated freeze/thaw cycles, 
extended use of the kit beyond recommended storage 
conditions, or the introduction of chemical factors (i.e., 
cleaning reagents)  
 
Source: Thermo Fisher Scientific Technical Note dated 
November 29, 2017 

D2S441 n-2 to n-2.5 
bp 

Probable cause is a DNA 
template dependent 
artifact likely caused by 
n-2 stutter or the 
formation of a secondary 
structure in the target 
sequence 

Signal intensity is relative to the DNA input amount (~0.5% of 
the parent peak height) 
 
 
 
Source: Thermo Fisher Scientific Technical Note dated 
November 29, 2017 

D3S1358 ~132 bp probable cause is non-
STR amplification by-
product 

Has been observed in samples; has not been observed in PCR 
negative controls.  Although the artifact peaks are typically 
present at low levels, they may be observed depending on DNA 
input amount and the peak detection threshold used for 
analysis. 
 
Source: developmental validation 

Before 
D5S818 

~131 bp Likely a human 
microvariant associated 
with the D5S818 marker 

This artifact was found to be consistent with the D5S818 
marker during primer screening and the artifact sequence has 
homology with chromosome 5 of the human genome. 
 
Source:  Thermo Fisher sequencing of HFSC amplicon 

D5S818 ~142 bp 
 

probable cause is the 
presence and 
amplification of non-
human DNA 
 

Sequencing studies have shown that the amplicon produced is 
homologous to the Lachnoclostridium genome.  Has been 
observed in sample types potentially exposed to fecal matter, 
such as rectal and peri-anal swabs 
 
Source: Thermo Fisher Scientific Technical Note dated 
November 29, 2017 

D5S818 ~180 bp probable cause is non-
STR amplification by-
product 

Has been observed in samples; has not been observed in PCR 
negative controls.  Although the artifact peaks are typically 
present at low levels, they may be observed depending on DNA 
input amount and the peak detection threshold used for 
analysis.  Signal intensity relative to input amount, typically 
<175 RFU with a 1 ng template input 
 
Source: developmental validation, Thermo Fisher Scientific 
Technical Note dated November 29, 2017 
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Before 
D7S820 

~250 bp probable cause is the 
presence and 
amplification of non-
human DNA 

Sequencing and an NCBI BLAST search revealed homology with 
the Porphyromonas asacchharolytica genome (bacteria). 
 
 
Source:  Thermo Fisher sequencing of HFSC amplicon 

D8S1179 ~114-121 bp probable cause is a DNA 
template independent 
artifact likely caused by a 
dye derivative (dye 
amide), which is a 
cleavage of the dye from 
the labeled primer at the 
amide linkage  

Typical signal intensity is <175 RFU; may be promoted by post-
manufacturing activities, such as repeated freeze/thaw cycles, 
extended use of the kit beyond recommended storage 
conditions, or the introduction of chemical factors (i.e., 
cleaning reagents)  
 
 
Source: Thermo Fisher Scientific Technical Note dated 
November 29, 2017 

D21S11 ~207 bp probable cause is the 
presence and 
amplification of non-
human DNA 

Has been observed in samples with low or undetermined 
quantitation results; has not been observed in PCR positive or 
negative controls. Sequencing studies have shown that the 
amplicon produced is homologous to yeast and fungal species 
commonly found in the environment, such as from plants, soil 
and decaying organic matter with no sequence homology to 
the human genome. 
 
Source: developmental validation 

SE33 n-90 bp 
 

low level binding of the 
D3-unlableed primer to 
the SE33 region internal 
to the SE33 primer 
binding sites, specifically 
caused by a single 
nucleotide 
polymorphism that exists 
within a segment of the 
population of African and 
European descent 

Typically observed ~90 nucleotides before the parent SE33 
peak(s).  Sequencing studies have shown that the amplicon 
produced is homologous the human genome.  Signal intensity 
is relative to the amount of contributor present with the SNP 
(~15% to 30% of the parent peak height).  Depending on the 
location of the parent SE33 allele containing the SNP, the 
artifact could appear in D13S317, D7S820, or SE33. 
 
 
Source: Thermo Fisher Scientific Technical Note dated 
November 29, 2017 

SE33 ~352.5 bp probable cause is the 
presence and 
amplification of non-
human DNA 

Sequencing and an NCBI BLAST search revealed homology with 
the Kosakonia cowanii and Klebsiella pneumoniae genomes.  
 
Source:  Thermo Fisher sequencing of HFSC amplicon 

TH01 n-10 to n-12 likely caused by 
secondary structure 

There is a direct correlation between the signal intensities of 
the N-12 artifacts and the TH01 alleles with the artifact peak 
heights that range from 0.4% to 0.9% of the TH01 allele peak 
heights.  Although the artifact peaks are typically present at 
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low levels, they may be observed depending on DNA input 
amount and the peak detection threshold used for analysis. 
 
Source: developmental validation, Thermo Fisher Scientific 
Technical Note dated November 29, 2017 

TPOX n-24 likely caused by 
secondary structure 

Although the artifact peaks are typically present at low levels, 
they may be observed depending on DNA input amount and 
the peak detection threshold used for analysis. 
 
Source: developmental validation 

vWA  ~204 bp probable cause is the 
presence and 
amplification of non-
human DNA 
 

Has been observed in samples with low or undetermined 
quantitation; has not been observed in PCR positive or 
negative controls.  Sequencing studies have shown that the 
amplicon produced is homologous to yeast and fungal species 
commonly found in the environment with no sequence 
homology to the human genome. 
 
Source: developmental validation 

Y Indel ~84 bp probable cause is the 
presence of non-STR 
amplification by-product 

Can vary in peak height from lot to lot and sample to sample 
but typically <175 RFU with a 1 ng template; may be observed 
in male and female samples 
 
Source: Thermo Fisher Scientific Technical Note dated 
November 29, 2017 

 
Activity that is suspected to be artefactual in nature but is not listed above must be reported to the DNA 
Technical Leader.  The sample may be re-injected and/or re-amplified in an effort to reproduce the 
questionable activity.  
 

1.1.4 Microvariants 
1.1.4.1 Microvariants are true alleles that vary by fewer than 2 or 4 bp from the typical 

repeating unit.  The designation of alleles containing an incomplete repeat unit, 
falling within the range spanned by the ladder alleles includes the number of 
complete repeats, a decimal point, and then the number of base pairs in the 
incomplete repeat (e.g. 9.3 for a TH01 allele with 9 full repeats plus three more 
bps).  The determination of the number of additional bp present in a microvariant is 
made by comparing the bp size of the off ladder peak with the bp size of the 
flanking alleles in the allelic ladder.  If the locus is heterozygous, evaluate the sister 
allele to help establish whether the off-ladder allele is truly a microvariant, or simply 
off-ladder due to electrophoretic drift. 

 
If an allele is sized smaller than or larger than the smallest or largest ladder allele at a 
locus, and not in a virtual bin, it shall be designated as greater than or less than the 
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appropriate ladder allele (i.e. > 11 for TH01).  Any allele designated as off-ladder by 
GeneMapper and not determined to be an artifact is verified by re-injection or re-
amplification.  If the microvariant appears in multiple evidence samples from the 
same case otherwise having the same profile, or the microvariant is also contained in 
the DNA profile of an assumed contributor that is consistent with the evidence, it is 
not necessary to re-inject the evidence or the assumed contributor’s reference.  
Because every measure is taken to interpret evidence samples prior to reference 
samples, the presence of a microvariant in an associated known sample does not 
suffice for confirmation in a single evidentiary profile, as the evidence is interpreted 
before and separate from any associated knowns in the case.  A reference that 
contains a microvariant does not need to be re-injected if: 1) it is consistent with 
evidence that has already been re-injected for confirmation; or 2) it is consistent 
with an evidentiary profile that is observed in multiple evidence samples. 
 
If a mixture has been evaluated and determined to be uninterpretable but contains  
an off-ladder allele, the analyst may choose to forgo the confirmation process (e.g.,  
re-injection) and report the allele as “INC”.  This option would only be exercised  
when the act of confirming the off-ladder allele would not aid in the interpretation of  
the mixture and no future comparisons to the mixture can be foreseen.   

 
It is recommended that analysts visit http://www.cstl.nist.gov/strbase/var_tab.htm 
(Variant Allele Reports) for a given off-ladder allele.  A printout of the previously 
observed off-ladder allele may be retained in the case file. 
 
It is possible for alleles to fall outside the range of their locus and to be detected in 
the size range of a neighboring locus. E.g.: an allele 25 in locus D3S1358 would be 
detected in the lower range of locus vWA. Such possibilities should be considered 
when a locus has a tri-allelic pattern in a locus adjacent to an apparently 
homozygous locus. If the apparently homozygous allele is of an RFU intensity similar 
to that of other heterozygous alleles, and of similar intensity to the allele in question, 
then the locus to which the off-ladder allele belongs may not be determined. Both 
loci in question will be designated as inconclusive. 

 
1.1.5 Re-analysis and Additional Analysis 

1.1.5.1 Any step in the process with unacceptable controls (as defined in this SOP) must be 
rerun.  Refer to the General DNA SOP (Quality Assurance) for instructions on 
investigation and reanalyzing samples where contamination is detected or is 
suspected.  Data from analysis with unacceptable controls may not be used for 
interpretation.  

 
The analytical threshold is the “minimum height requirement at and above which detected 
peaks can be reliably distinguished from background noise”8.  Peaks above this threshold are 
generally not considered noise and are either artifacts or true alleles.  The analytical 

http://www.cstl.nist.gov/strbase/var_tab.htm
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threshold for Identifiler Plus amplifications is 50 RFUs.  The analytical thresholds for 
GlobalFiler are color-specific:  
 

Dye Color Minimum Analytical Threshold (RFU) 
Blue 80 

Green 60 
Yellow 70 

Red 60 
Purple 60 

 
The limit of detection (LOD) is defined as the threshold at which signal in the form of data 
peaks can be reliably distinguished from noise.  The limit of quantitation (LOQ) reflects a 
point at which signal can be reliably quantified (e.g., subject to allelic designation).  Because 
a signal just above the LOD is likely contaminated with some noise, it should not be used in 
quantitation comparisons until it also exceeds the LOQ(13).  Both LOD and LOQ can be 
considered the analytical threshold, but HFSC considers the LOQ the analytical threshold.  
The LOD, or minimum peak detection threshold, can be used in the analysis of negative 
controls, including reagent blanks and amplification negatives, to investigate possible 
activity.  Activity that does not exceed the minimum peak detection threshold (LOD) or the 
analytical threshold (LOQ) will not generally be considered contaminating DNA; however, 
the quantity of peaks and peak morphology will be taken into consideration when activity 
below the minimum peak detection threshold (LOD) or the analytical threshold (LOQ) is 
observed in any negative controls. 

 
Interpretive caution must be used when activity is observed below all analytical 
thresholds. 
 
If low levels of DNA provide insufficient data or data below the analytical or 
stochastic threshold upon initial analysis, the analyst may choose any of the 
following (as long as relevant maximums specified in the SOP’s are not exceeded): 

• Re-amplify the sample with more template DNA (or less template DNA, if 
inhibition is suspected). 

• If multiple sets of data are available for a given sample extract due to re-
amplification or re-injection, the profile with the higher/highest quality of 
data shall be reported, which may not always be the data with the most 
labeled alleles. 

 
1.1.5.2 The associated reagent blank and amplification negative control must also be 

subjected to the same concentration and injection conditions as required by the 
forensic sample(s) containing the least amount of DNA.   

 
1.1.5.3 Samples with excessive RFUs (>~4000 RFUs on the 3130xl, >~13,000 RFUs for 

heterozygous peaks on the 3500xl, and >~26,000 RFUs for homozygous peaks on the 
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3500xl) must be interpreted with caution.  Excessive template DNA can make data 
interpretation difficult with a greater propensity for pull-up/matrix failure, as well as 
possible non-specific amplification.  A phenomenon known as over-subtraction 
could cause elevated pull-up, stutter and minus A peaks when the analysis software 
normalizes the true off-scale peak(s) but does not adjust the artifacts (because they 
are not off-scale).  This may also result in a loss of linearity in RFU increase when 
injection times are extended.  Re-evaluate the quantification data to ensure the 
correct amount of template was amplified.  The sample may be re-analyzed to 
obtain suitable data through any of the following: 

• Dilute the amplified product in TE buffer, add 1 µl to the formamide/LIZ 
mixture, and re-inject  

• Re-amplify the sample with less template DNA. 
 

1.1.5.3.1 Results with artifacts that interfere with interpretation may be re-analyzed 
as needed to resolve the issue: 

• Artifacts resulting from poor electrophoresis may simply be re-injected. 
• Artifacts resulting from excessive DNA may be re-injected for a shorter time, diluted and re-

injected, or re-amplified with less DNA.   
• Artifacts that are a result of poor amplification, such as excessive –A, are typically resolved best 

by re-amplification. 
• Pull-up due to a poor spectral can only be resolved by running a new spectral or performing 

other instrument maintenance. 
 

1.1.6 Interpretation Guidelines 
 

1.1.6.1 Results and conclusions from DNA analysis must be scientifically supported by the 
analytical data with appropriate standards and controls.  Interpretations are made 
as objectively as possible.  Not every situation can nor should be covered by a 
specific rule and situations may occur that require an analyst to deviate from stated 
guidelines.  Expectations of alleles per locus, heterozygous peak height ratios, and 
major/minor ratios are stated below.  It is expected that limited variance from these 
values may occur.  Analysts shall utilize their training and experience to address 
these variances.  Both the reporting analyst and reviewer shall agree on all variances 
that are accepted.  If an agreement between the reporting analyst and reviewer 
cannot be reached, consultation with a more experienced analyst or supervisor may 
help.  If an agreement is still not reached, the variance shall be brought to the 
attention and decision of the Technical Leader.  Case documentation including, but 
not limited to, any and all assumptions must be sufficient for another experienced 
analyst to identify and understand the deviation from stated guidelines.    

 
1.1.6.2 Whenever possible, evidentiary samples are to be completely evaluated prior to the 

evaluation of any reference samples that are to be compared, with the exception of 
intimate samples and the assumed contributor (an individual whose DNA on an item 
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of evidence is reasonably expected).  The decision to attempt to develop a profile 
further through re-injection or re-amplification is made without knowledge of the 
known profile for comparison, other than those of assumed contributors.   

1.1.6.2.1 Fractions of a differential may be used to interpret each other (i.e., a single-
source or single-source major profile may be used to deduce the obligate 
alleles of a second contributor in the corresponding fraction for the same 
differential extraction). 

 
1.1.6.3 Intimate samples are those in which it is expected that a known contributor may be 

found on the evidence. These include, but are not limited to, samples contained in a 
sexual assault kit that were collected from the body of the complainant, clothing 
removed from the complainant or suspect, and swabs taken directly from the body 
of an individual.  Conclusive documentation from the submitting agency must exist 
for a sample to be considered intimate.  The medical report contained within a 
sexual assault kit will suffice for documentation of items collected as part of the 
sexual assault examination.  The DNA Technical Leader, the Forensic Biology 
Manager, or the DNA Interpretation Supervisor must approve all intimate samples 
other than those listed above, as well as any non-intimate items for which a 
contributor will be assumed.    
 

1.1.6.4 Types of Conclusions 
1.1.6.4.1 Three types of conclusions are generally possible when both evidence 

(questioned) and reference (known) samples are tested and compared:  
• Inclusion/cannot be excluded: the individual could have contributed to the questioned profile; 

for a single-source sample, the same genotypes were obtained by an evidentiary sample and a 
reference sample, with no unexplained differences; for a mixture profile, all of the alleles from 
the reference sample are accounted for in the mixture profile of an evidentiary item (the loss of 
an allele due to incomplete (preferential) amplification, stochastic effects, mutation, or other 
factors must be considered and does not necessarily indicate an exclusion) 

• exclusion: the individual could not have contributed to the questioned profile; the genotype 
comparison shows profile differences that can only be explained by the two samples originating 
from different sources 

• inconclusive: the data does not support a conclusion; insufficient information exists to support 
any conclusion.  The reason for inconclusive results must be clearly stated in the report.   

 
1.1.6.4.2 Inclusion or exclusion is determined by qualitative and quantitative 

evaluation of the entire DNA profile produced at the various loci tested.  
Inconclusive results, or an uninterpretable profile, may result from, but are 
not limited to: 

• Insufficient amounts of template DNA 
• Degradation, inhibitors, or data of otherwise poor quality 
• Mixtures of DNA from multiple donors 
• Data that does not meet quality assurance guidelines 
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1.1.6.4.3 It may be acceptable for an inclusion or exclusion to be determined when 

one or more loci yield inconclusive results.  An inclusion statement, and any 
resulting statistical calculations, shall be based only on loci that yield 
conclusive results.  An exclusion statement can be determined if even a 
single locus produces exclusionary results.  However, an exclusion cannot be 
determined if technical issues such as the loss of an allele due to incomplete 
(preferential) amplification, stochastic effects, mutation, or other factors 
may have caused the non-match.  

 
1.1.6.4.4 Comparisons (e.g., inclusions/exclusions) should not simply be based on the 

presence or absence of alleles for a particular contributor at a given locus, 
but instead be based on the possible genotype(s) that are being evaluated 
for each contributor at each locus while considering the overall quality of 
the profile (e.g., degradation, preferential amplification, inhibition, drop-
out) and any assumptions being made with the interpretation. 

 
1.1.6.4.5 It may also be possible to obtain a conclusive result comparing one 

reference to a questioned sample but an inconclusive result when 
comparing a second reference sample to the same questioned sample.  This 
is most commonly observed when interpreting complex mixtures. 

 
1.1.6.4.6 The simple presence or absence of alleles may be insufficient to draw a 

proper conclusion due to the possibility of allelic drop-out. 
 

1.1.6.5 Types of Profiles 
1.1.6.5.1 A number of different types of profiles may be obtained from evidence 

samples.  The comparisons with references that can be made are 
determined by the type of profile. 

 
1.1.6.5.2 No profile: No DNA results obtained at all.  No comparison can be made to 

reference samples. 
 

1.1.6.5.3 Uninterpretable: Data obtained, but insufficient for comparison.  This may 
be due to data at too few loci, data below the stochastic threshold, or when 
the overall quality of the data is questionable.  Indistinguishable mixtures 
that contain excessive contributors may also be uninterpretable.  No 
comparison can be made to reference samples. 

 
1.1.6.5.4 Single source profile:   

• It is expected that a single individual should have no more than two alleles per 
locus 
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• If a sample has a third peak at just a single locus, with no other indication of 
a mixture, this may indicate an unusual mutation present in that individual 
(i.e. tri-allelic). Such a profile may be still considered single-source but must 
be interpreted with caution.  The sample may be re-injected, re-amplified, 
or re-extracted at the analyst’s discretion.  

• It is expected that a single individual should exhibit a heterozygous peak 
height ratio of >60%.  The peak height ratio (PHR) is calculated by dividing 
the peak height of an allele with a lower RFU value by the peak height of an 
allele with a higher RFU value, then multiplying by 100 to express the PHR 
as a percentage.  Possible contribution of stutter is not subtracted prior to 
application of this 60% criterion. If a sample has unbalanced peak heights 
with no other indication of a mixture, the sample may also be considered 
single-source but must be interpreted with caution. 

• Full single source profiles shall be entered into the Forensic Unknown 
category of CODIS.  However, single alleles submitted to CODIS must be 
marked as partial if they are detected below the stochastic threshold or if 
activity below the analytical threshold is observed, in which case the profile 
will be entered as a Forensic Partial.   
 

1.1.6.5.5 Inclusions with profiles can be made with respective statistics calculated 
and reported on probative samples. Without an explained reason, inclusions 
must account for all alleles present. Exclusions with full profiles can be 
made if the individual being compared differs from the evidentiary profile at 
any one locus.  If one or few non-matches are observed, evaluate the 
profiles carefully for evidence of dropout or artifacts that may have resulted 
in the non-match. 

 
1.1.6.5.6 Partial profiles: Partial profiles exhibit allelic or locus dropout in some loci 

tested and can result from insufficient, degraded, or inhibited DNA.  
Typically, smaller loci amplify better under these conditions and larger loci 
tend to drop out.   Extremely low levels of template DNA may also lead to 
stochastic effects which may under-represent one allele of a heterozygous 
locus.  Again, care must be taken to ensure that non-matches are not a 
result of drop-out.   For partial profiles, the determination of which 
alleles/loci are suitable for comparison and statistical analysis should be 
made prior to comparison to the known profiles.  

 
Partial profiles shall be entered into the Forensic Partial category of  
CODIS.  As with full single source profiles, single alleles submitted to CODIS 
must be marked as partial if they are detected below the stochastic 
threshold or if activity below the analytical threshold is observed. 
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1.1.6.5.7 Mixtures: Evidence samples may contain DNA from more than one 
individual. A mixture can consist of full and/or partial profiles from multiple 
individuals.  One or more of the following may indicate the presence of a 
mixture: 

• Greater than two alleles at a locus, excepting tri-allelic loci. 
• A peak at the stutter position of significantly greater RFUs than is typically 

observed. 
• Peak height ratios between a single pair of allelic peaks for one or more 

loci are below the empirically determined heterozygous peak height 
ratio expectation  

• Clear evidence of additional allelic activity below analytical threshold.   
• Caution must be used if only a single example of a mixture is observed.   

 
Number of Contributors 

• Generally, the counting of alleles at the locus that exhibits the greatest number of allelic peaks 
can provide guidance towards determining the minimum number of contributors.  For example, 
if at most five alleles are observed at a locus, then the DNA results are consistent with having 
arisen from at least three individuals.  Proceed with caution when only one allele in the entire 
sample would lead to an increased number of possible contributors, as stutter, imbalance, and 
the potential for a tri-allele can complicate mixture interpretation.  Loci more likely to exhibit a 
tri-allele pattern are D18S51, D21S11, FGA, TPOX, and vWA. 

 
• While counting allele peaks is very useful in determining a minimum number of contributors, 

the analyst must also consider allele sharing between individuals and allelic dropout may result 
in an underestimate of the actual number of contributors.   

 
• Determination of a finite number of contributors may be possible based on analysis of the data.  

Number of alleles per locus, peak height balance, and Y-STR data may further support the 
assumption of the number of contributors.   

 
• The information at all loci across the profile must be used in evaluating the number of 

contributors and in determining their relative proportions. 
 

• Using a known reference to account for alleles in an intimate sample can aid in determining the 
number of contributors, including samples that may otherwise be uninterpretable, such as a 
complex mixture.   

 
• Mixtures may be reported as being from “at least” the fewest number of individuals possible, 

given the maximum number of alleles detected at a locus. 
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• If the evidence is assumed to consist of two or more close biological relatives, utilizing allele 
counts may underestimate the true number of contributors to the evidence due to the high 
degree of allele sharing. 

 

• All unambiguous alleles above the analytical threshold, including those that do not meet or 
exceed the stochastic threshold, shall be used when assessing a finite or a minimum number of 
contributors to a DNA mixture.   
 

• When data above analytical is consistent with a single contributor, but data is observed below 
the analytical threshold that may suggest an additional contributor(s), this information shall not 
be used to quantify the number of contributors but shall be communicated in the DNA report 
(eg, Data was observed below threshold that could indicate an additional contributor(s).).  

 
Two types of mixtures may be observed: 
• Mixture with Major/Minor Contributors 

o Some mixed source profiles may be clearly deconvoluted into major and minor components.  
A major component may consist of a single contributor or may be comprised of a mixture of 
two or more contributors.  Major components of a single contributor in a two-person 
mixture should abide by the guidelines of a single source profile, including a heterozygous 
peak height ratio of approximately 60%.  

 
o Identification of a major component can be fairly straightforward when it is two person 

mixture, the major is a single contributor, and the ratio of individuals is 4:1 or greater.  As 
the ratio moves closer to 1:1, or the number of contributors increases, it can become more 
difficult to distinguish the major component.   

 
o A major component can be identified by several means.  If the highest minor peak is less 

than ~ 35% for Identifiler Plus amplifications and ~25% for GlobalFiler, or the ratio of 
major/minor components can be considered and be ~4:1 or greater.   

 
Determining major/minor using peak height ratio: 

 
Divide the peak height of the tallest “minor” allele with the peak height of the shortest “major” allele 
and then multiply this value by 100 to express the PHR as a percentage.  It is acceptable practice to 
truncate to the whole number for major/minor peak height ration calculations (e.g., 25.6% can be 
treated as 25%).   

 
Determining major/minor using a ratio: 

 
Easiest to start with loci that have four alleles. 
(964+850): (240+195) 
1814: 435 
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4.2: 1 
(Assuming only 2 contributors) 

 

 
 
Use “known contributor” profile to assign alleles. 
Known is 14,19 
Unknown can most reasonably be assumed to be 15,16 
(201+143) : (115+141) 
344 : 256 
1.3 : 1 
(Assuming only 2 contributors) 

 

 
 
If “known contributor” is homozygous, look at loci with three alleles. 
Known is 16,16 
Unknown can most reasonably be assumed to be 15,17 
(580) : (934+974)  
508 : 1908  
1: 3.3 
(Assuming only 2 contributors) 
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What if minor is shared? 
(580+580) : (934+(1554-580))  
1160: 1908  
1 : 1.6 
(Assuming only 2 contributors) 

 
Examine Amelogenin if mixture is female:male 
Visually this appears to be approximately 6:1 ratio of contributors 
1125:172 
6.5:1 
 
HOWEVER, keep in mind that the X is shared between both contributors 
(1125 – 172) : (172 + 172) 
953:344 
2.8:1 
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Estimated ratio of contributors based on the assumption that the X and Y alleles of the male contributor 
are at 100% PHR 

 
 
• Various combinations of homozygous and heterozygous genotypes of the major and minor 

components, along with allelic sharing between contributors, may influence the balance such that 
the 35% (Identifiler Plus) or 25% (GlobalFiler) or 4:1 parameter may be exceeded or insufficient to 
truly identify a major component.  No prior adjustment for stutter is assumed but it is considered as 
a possibility.  Stutter from a major allele(s) may cause an artificial imbalance in the PHR calculation 
results of minor genotypes.   Contribution from a minor allele(s) may cause an artificial imbalance in 
the PHR calculation results of major genotypes due to allele stacking. As the number of contributors 
to a mixture increases, this effect may become more pronounced. 

 
• As RFUs approach the stochastic range (<1,000 RFUs for a 2-person mixture and <1,500 RFUs for a 

3+ mixture), consideration must be given to greater heterozygous imbalance within a contributor.  
Imbalance along with allele sharing could create a false major contributor within a locus. 

 
• If evaluation of the overall profile suggests the major and minor contributors may have “flipped” or 

if unexpected imbalance in a known contributor is observed, extreme caution must be employed 
when deconvoluting into major and minor components. 

 
• It is permissible to have a major component that may not be identified at all loci.  If a major 

component is not identified at all loci, then caution must be used when deciding to consider the 
profile a major/minor mixture versus an indistinguishable mixture. This is especially true as the 
number of contributors increases.  A major component may be identified when a majority of STR 
loci (at least eleven GlobalFiler STR loci, not including YIndel, Amelogenin and/or DYS391) meet the 
major/minor PHR or ratio thresholds.   

 
• If a major component is not identified at all loci, and a known DNA profile is not available for 

deduction, the profile shall be entered into CODIS in either the Forensic Partial or Forensic Mixture 
category.  For the loci where the major component is not identified, a CODIS entry is not allowed 
without approval of the DNA Technical Leader, the Forensic Biology Manager, or the DNA 
Interpretation Supervisor. 



      Biology/DNA  
DNA Interpretation SOP 

Biology/DNA Division 
  
 

 
DNA Interpretation SOP Document ID: 25414 
Issued By: Section Technical Leader  Issue Date: September 10, 2018 
Uncontrolled When Printed Page 32 of 61 
 

 
• A mixture assumed to be of three contributors must have a major (single or multiple contributors) at 

all loci or the approval of the Technical Leader, the Forensic Biology Manager, or the DNA 
Interpretation Supervisor.  Due to the uncertainty introduced in complex mixtures from allele 
sharing/stacking, major/minor deconvolutions shall adhere to the 60% PHR of a single-source profile 
and the 25% PHR criteria of a major/minor deconvolution, without the subtraction of possible stutter, 
at a minimum of sixteen of the twenty-one STR loci. 

 
• A mixture assumed to be of four contributors must have a major (single contributor) at all loci or the 

approval of the Technical Leader, the Forensic Biology Manager, or the DNA Interpretation Supervisor.  
Due to the uncertainty introduced in complex mixtures from allele sharing/stacking, major/minor 
deconvolutions shall adhere to the 60% PHR of a single-source profile and the 25% PHR criteria of a 
major/minor deconvolution, without the subtraction of possible stutter, at a minimum of sixteen of 
the twenty-one STR loci. 

 
• Not all alleles of a minor component to a mixture may be determined since minor component alleles 

may be masked.   
 
• After deconvolution, the DNA typing results attributed to a single minor contributor should also 

meet PHR expectations. The PHR expectations of a minor contributor may be reduced due to 
stochastic peak height variation and the additive effects of peak sharing (e.g., minor peak and 
stutter peaks).  While imbalance may be explained by stochastic variation and sharing, excessive 
imbalance may also be evidence of more than one minor contributor. 

 
• Determination of a single genotype for a minor contributor may be possible at only some loci 

because multiple possible genotypic combinations, potential allelic dropout, and/or masking of the 
minor contributor’s alleles by those of the major contributor or by stutter from the major 
contributor’s alleles preclude such determination at other loci.  When overall the minor contributor 
is in the stochastic range, only distinctly foreign activity shall be deduced, as evaluating balance for 
sharing is less reliable in the stochastic range. 

 
• Consideration must be given to the possibility of the “swapping” of the major and minor 

contributors should one of the components exhibit evidence of degradation.  If the major 
component is degraded, what appears to be from the major contributor at the loci of shorter 
fragments could appear to be from the minor component at the loci of longer fragments. 

 
• Trace alleles may also be detected in a mixture.  Trace alleles are minor to a minor component.  

They are called when the highest trace allele is less than 35% (Identifiler Plus) or 25% (GlobalFiler) of 
the lowest minor allele.  An allele that meets this designation may not be a trace allele if the mixture 
does not appear to be greater than two individuals.  Extreme caution must be exercised when trace 
alleles are observed and they are close to the 35% or 25% threshold.   
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• Mixtures with indistinguishable contributors (unresolved mixture) 
• A mixture must be considered indistinguishable when the major and minor components cannot 

be distinguished because of signal intensities.  Individuals may still be included or excluded as 
possible contributors to the mixture. All interpretable loci are used in evaluating whether a 
person is included or excluded as a possible contributor.  When evaluating whether a person 
should be excluded as a possible contributor, if an allele is not present at a locus, care must be 
taken to consider whether the allele may be missing due to drop-out.   This determination can 
be difficult to make and consultation with a more experienced analyst or supervisor may be 
helpful.  Such consultations shall be documented in the case file with the initials of the 
consulted person(s) and the date of the consultation on the electropherogram of the sample(s) 
in question. 
 

• Indistinguishable mixtures of three or four individuals (complex mixtures), or the minor 
component of the distinguishable three or four-person mixtures, must be interpreted with 
extreme caution.  Allele sharing/stacking of alleles due to sharing creates more uncertainty9.  
Furthermore, preferential amplification of alleles within a locus attributable to large differences 
in base pair size, or resource competition in complex mixtures, may result in a loss of allelic 
activity or even allelic drop-out. Therefore, the use of indistinguishable or minor components of 
complex mixtures must be approved by the Technical Leader.   
 

• Mixtures with an assumed contributor 
• Mixture deduction allows for the identification of obligate unknown alleles in a mixture given 

that a known contributor is present.  This deduced profile is then eligible for comparison and 
statistical analysis as a single source sample.   
• It may not be possible to determine a complete genotype for the unknown contributor.    
• When a heterozygous genotype cannot be deduced and only a single obligate allele may 

be determined for the unknown contributor, then consideration must be given to any 
possible sister alleles.  Three common reasons for a single allele may be: 
• The unknown contributor is homozygous.  
• A heterozygous sister allele is masked by the known contributor. 
• A heterozygous sister allele has dropped out. 

• Suitable mixtures are two person mixtures from intimate items with a finite number of contributors 
with one of the contributors known, prior to interpretation.   

• The major component of a three or more person mixture may be eligible if a finite number of two 
contributors are identified in the major component and one contributor is known, prior to 
interpretation.   

 
Steps for deduction: 
• Identify the alleles in the mixture that are attributed to the known individual.   
 
• Identify the remaining obligate alleles: 
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• When 4 alleles are present: Identify which alleles are being contributed by the assumed 
contributor.  The remaining 2 alleles are assumed to belong to the foreign contributor.  Loci 
at which a distinct genotype has been established for the unknown contributor are useful in 
identifying the approximate ratio of the two contributors. 

• When 3 alleles are present and the assumed contributor is homozygous:  Identify which 
allele is being contributed by the assumed contributor.  The remaining 2 alleles are assumed 
to belong to the foreign contributor. 

• When 3 alleles are present and the assumed contributor is heterozygous:  Identify which 
alleles are being contributed by the assumed contributor.  It is possible that the remaining 
allele is a homozygous peak from the foreign contributor.  Alternatively, it may be one of 
two heterozygous peaks where the other peak is shared with the assumed contributor.   

• When 2 alleles are present and the assumed contributor is homozygous:  Identify which 
allele is being contributed by the assumed contributor.  The remaining allele is assumed to 
belong to the foreign contributor.  It is possible that the remaining allele is a homozygous 
peak from the foreign contributor.  Alternatively, it may be one of two heterozygous peaks 
where the other peak is shared with the assumed contributor.   

• When 2 alleles are present and the assumed contributor is heterozygous:  It is possible 
that the foreign contributor is also heterozygous and shares his/her alleles fully with the 
assumed contributor.  It is also possible that the foreign contributor is homozygous.  
Consider an observed profile peak height ratio difference when making this determination.  
If there are no alleles foreign to the known individual, but significant imbalance is observed, 
analysts must use caution when deducing a foreign profile.  If the foreign profile may be 
experiencing dropout, such as with a minor component, deduction is not permissible 
without written approval from the Technical Leader.  The entire profile shall be evaluated to 
determine whether dropout is a possibility.  When the deduced profile is in the major 
component or otherwise expected to be fully represented, it is not necessary to have 
written approval from the Technical Leader.  

 
Once the obligate alleles are identified: 
 

• Identify loci with one obligate allele above stochastic threshold and in stutter position. 
• The maximum allowed stutter at each locus must be calculated and subtracted from the 

obligate allele RFU.  This modified RFU value is now used to evaluate the obligate allele.  
If this causes the RFU value to drop below the stochastic threshold, a homozygous 
genotype cannot be deduced.  If this causes the RFU value to drop below the analytical 
threshold, no deduction is permissible. 

• If a peak is at or below the stutter threshold there are two possibilities: either the 
peak is completely stutter or it is a composite of stutter product and an allele from 
another contributor. The peak should be considered as potentially a composite of 
stutter and allele if the peak height of the potential stutter peak(s) is consistent with 
(or greater than) the heights observed for any allelic peaks that are conclusively 
attributed (i.e., peaks in non-stutter positions) to the minor contributor(s). The 
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designation of stutter peaks as possible allelic peaks is unnecessary at a locus if the 
consideration of stutter peaks would violate the documented assumption as to the 
number of contributors to the mixture (e.g., a two-person distinguishable mixture 
with four alleles).  Peaks identified as complete stutter may not be submitted to 
CODIS. 
 

• Identify the loci where the obligate allele is below stochastic threshold and dropout is 
reasonable to have occurred. 

• No further deduction is permissible at these loci. Document the obligate allele and a 
dash (--) to indicate that drop out is possible. 

• The single foreign allele must be marked as “partial” when submitted for CODIS. 
 
 Examine the remaining loci with one obligate allele above stochastic threshold. It may be 

possible to determine a distinct genotype for the unknown contributor. 
• To minimize adventitious candidate matches in CODIS, instead of just entering the 

“obligate” foreign allele, enter the “obligate” foreign allele and one or both other alleles 
attributed to the known contributor, depending on peak height ratios, when all activity 
is above the stochastic threshold and there is minimal concern for drop-out. 

 
• Examine the RFU values for the alleles of the known contributor to determine if sharing with the 

foreign contributor could be occurring.  Caution must be taken as natural heterozygous 
imbalance could lead to an incorrect deduction.   
• When the overall profile is in the stochastic range (<1,000 RFUs for a 2-person mixture and 

<1,500 RFUs for a 3+ mixture), only distinctly foreign activity shall be deduced, as evaluating 
balance for sharing is less reliable in the stochastic range. 

• If evaluation of the overall profile suggests the major and minor contributors may have 
“flipped” or if unexpected imbalance in the known contributor is observed, only distinctly 
foreign activity shall be deduced. 

 
• Document the final genotype of the unknown contributor on the plot.  Use a dash (--) with any 

single allele if the unknown is not being identified as homozygous.   
 

• Any uncertainty in a deduced profile shall be reflected in the CODIS profile submission for that 
deduction.   

• If a locus is excluded from the deduction process, that locus may not be submitted for 
CODIS. 

• If a single-allele with a dash (--) is deduced at a locus, a distinct heterozygous genotype 
may not be submitted for CODIS at that locus.   

• If a complete deduction is not permissible at all loci, or if any homozygous deductions 
are below the stochastic threshold or include a dash (--) because of possible drop out or 
masking, the single-source deduction may not be submitted as a Forensic Unknown.  It 
may only be a Forensic Partial or a Forensic Mixture. 
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• Single alleles submitted to CODIS must be marked as partial if they are detected below 
the stochastic threshold or if activity below the analytical threshold is observed, in 
which case the profile will be entered as a Forensic Partial.   

 
• At times, comparison of a questioned profile to a reference profile will render some of the 

interpretational or operating assumptions made regarding that questioned profile inaccurate.  
In those instances, if the discrepancies can be reasonably attributed to amplification, genetic, or 
other outliers, the analyst shall drop the locus in question from a frequency estimate and 
proceed with reporting the association.   If more than one inconsistency occurs, the entire 
profile should be determined to be inconclusive or as an exclusion of the compared standard.   
 

       If the discrepancies cannot be reasonably attributed to biology-related outliers, such as with  
       incorrect assumptions (eg, number of contributors or an assumed contributor) or a  
       misapplication of scientific concepts (eg, failing to consider stochastic-related imbalance), the  
       analyst shall drop the locus in question from a frequency estimate and proceed with reporting  
       the association.  Issues of this nature will be tracked through a Qualtrax workflow regardless of    
       whether an amended report is warranted (eg, the original deduction was not included in a  
       report allele chart). 

 
The reasons for dropping the locus and recalculating the frequency estimate(s) shall be clearly 
documented within the examination documentation.  Any post-comparison revisions to the 
interpretation must be clearly documented in the case notes and shall include detailed scientific 
reasoning for the revision, the date of change and initials of the reporting analyst, and the 
initials of the Technical Leader.   

 
1.2 Interpretation of Forensic Parentage and Relationship Cases 

1.2.1 For parentage cases, reference guidelines established by the AABB Relationship Testing 
Standards.  Greater details of these standards and recommendations can be found in 
their published Standards for Relationship Testing Laboratories and Guidance for 
Standards for Relationship Testing Laboratories.  The Popstats software (which used 
these AABB-recommended formulae) is used to calculate parentage statistics. 

 
1.2.2 Paternity analysis can be performed with a reference sample from the child and the 

alleged father (AF), with or without the biological mother.  However, the statistical 
results of a “not excluded” case are more significant if the mother is included in the 
testing.  Therefore, a reference sample from the mother should be obtained when 
possible.  A reference from the mother is required in the following two types of cases: 

1.2.2.1 The child’s sample is fetal tissue.  For fetal tissue samples, the mother must be 
typed in order to confirm that the tissue sample is of fetal, not maternal, origin.  
Failure to test the mother could result in a false exclusion.  Note: if the mother is 
unavailable and the tissue is determined to be from a male, it may be assumed that 
the tissue is of fetal origin and the results may be used in the paternity analysis. 
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1.2.2.2 The alleged father is a biological relative of the biological mother.  In this situation, 
the child is likely to share some alleles with the AF because of the biological 
relationship between the AF and biological mother.  Therefore, testing the mother is 
required in order to take into account this shared relationship.    

 
1.2.3 Definitions 

1.2.3.1 Likelihood Ratio: a Bayesian statistical calculation that estimates the likelihood of 
seeing the evidence in question under two competing hypotheses.   
 

1.2.3.2 Paternity Index (PI): a specialized likelihood ratio estimating the likelihood of seeing 
the child’s profile if (1) the AF is the biological father versus (2) the AF is unrelated 
(or another competing hypothesis).     

 
1.2.3.3 Combined Paternity Index (CPI): The product of all individual Paternity Indexes 

 
1.2.3.4 Probability of Paternity: The probability, expressed as a percentage, that the AF is 

the biological father of the child.  This calculation is dependent on the CPI and prior 
probability assumption. 

 
1.2.3.5 Mutation:  A change in DNA resulting from a copying error during DNA replication.  

In STR analysis, this can result in a non-matching allele between a biological parent 
and child.  

 
1.2.3.6 Obligate paternal allele: the child’s allele(s) at a locus that must have been inherited 

from the biological father.  If the child is heterozygous at a locus and it cannot be 
determined which of the two alleles came from the biological father, then both 
alleles must be considered obligate. 

 
1.2.4 Exclusion 

1.2.4.1 An AF shall be excluded as the biological father if in more than two loci, the AF does 
not share an obligate paternal allele with the child.  In this case, no statistical 
calculations are required. 

 
1.2.4.2 In the event of exclusion, the analyst must evaluate the data for a possible sample 

switch between the biological mother and female child, alleged father and male 
child, and alleged father and other males processed simultaneously, including other 
alleged fathers.  A biological relationship shall be evident between the mother and 
female child, even if the samples were switched (for example, during collection).  A 
biological relationship shall not be apparent between the mother and male child if 
the male child and alleged father samples were switched, with the exception of 
cases where the mother and alleged father are biologically related.  In the event of 
exclusion, re-isolation of the excluded alleged father(s) may be conducted to verify 
the originally obtained profile(s).  Alternatively, strategic sample placement or 
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separate extractions may be used to eliminate the concern of a sample switch.  
These methods may also be employed regarding the child’s sample in the event of a 
motherless paternity with an excluded alleged father.  

 
1.2.5 Not Excluded, or Included 

1.2.5.1 If the AF shares an obligate paternal allele at all loci, he cannot be excluded as being 
the biological father of the child.  In this case the PI at each locus will be calculated 
by Popstats using the formulas in section 2 (Statistics). 

 
1.2.6 Inconclusive 

1.2.6.1 A comparison may be inconclusive when at two loci the AF does not share an 
obligate paternal allele with the child.  Additionally, a comparison may be 
inconclusive when at only one locus the AF does not share an obligate paternal 
allele with the child and a mutation is not suspected.   

 
1.2.7 Mutations 

1.2.7.1 Mutations in STR loci typically result in an allele one repeat shorter or longer than 
the parent allele.  These mutations occur at different frequencies in different loci 
and typically at a higher frequency in the larger loci.  If a non-match is observed in 
only one or two loci, the possibility of mutational events must be evaluated.  Two or 
more repeat mutations are seen at a lower frequency than single repeat mutations.   

 
1.2.7.2 If a non-match is observed at only one locus, the possibility of a mutation must be 

assumed and taken into account in the CPI calculation.  At the locus with the 
suspected mutation, a mutational PI is calculated for that locus following AABB 
recommendations.  This mutational PI is incorporated into the CPI calculation. 

 
1.2.7.3 If two non-matches are observed after standard laboratory STR (Identifiler Plus 

and/or GlobalFiler) testing, the results must be considered inconclusive.  
Supplemental testing, such as additional autosomal STR loci or Y STR analysis, may 
yield additional information in these cases.      

 
1.2.7.4 When a mutation is assumed and taken into account statistically, the DNA report 

must indicate which references were used.  An example of wording for the DNA 
report is:  

Note: The AABB Standards for Relationship Testing Laboratories, 10th Edition/Guidance Document was 
referenced for the mutation rate of locus D21S11.  The GlobalFiler™ PCR Amplification Kit User Guide 
(PN 4477604, Revision E) was referenced for the probability of paternity exclusion for locus D21S11. 
 

1.3 Y-STR Analysis and Interpretation Guidelines 
1.3.1 AmpFlSTR® Yfiler PCR Amplification Kit 

1.3.1.1 Y-Chromosome STR typing is an additional tool that can be used in concert with 
autosomal typing for the recovery of male DNA profiles in male: female mixtures 
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and mixtures with an abundance of female DNA, such as with a vasectomized male 
or a product of conception.  Y-STRs may also aid in determining the number of male 
contributors in a complex mixture. 

 
1.3.1.2 The following table shows the loci amplified by the Yfiler kit and the corresponding 

dyes used.  The AmpFlSTR Yfiler Kit Allelic Ladder is used to genotype the analyzed 
samples.  The alleles contained in the allelic ladder and the genotype of the Control 
DNA 007 are listed in the table. 

 

Locus Designation 
Alleles Included in 
Yfiler Kit Allelic 
Ladder 

Dye Label DNA 007 
Genotype 

DYS456 13-18 

6-FAM™ 

15 

DYS389I 10-15 13 

DYS390 18-27 24 

DYS389II 24-34 29 

DYS458 14-20 
VIC© 

17 
DYS19 10-19 15 
DYS385 a/b 7-25 11,14 
DYS393 8-16 

NED™ 

13 
DYS391 7-13 11 
DYS439 8-15 12 

DYS635 20-26 24 

DYS392 7-18 13 
Y GATA H4 8-13 

PET© 

13 
DYS437 13-17 15 
DYS438 8-13 12 
DYS448 17-24 19 

 
1.3.1.3 The AmpFlSTR® Yfiler® PCR Amplification Kit is a STR multiplex assay that amplifies 17 

Y-STR loci in a single PCR amplification reaction.  The loci amplified are in the 
“European minimal haplotype” (DSY19, DYS385a/b, DYS389I/II, DYS390, DYS391, 
DYS392, and DYS393), the Scientific Working Group-DNA Analysis Methods 
(SWGDAM) recommended Y-STR panel (European minimal haplotype plus DYS438 
and DYS439), and additional highly polymorphic loci (DYS437, DYS448, DYS456, 
DYS458, DYS635, and GATA H4).  DYS392 is a trinucleotide repeat, DYS438 is a 
pentanucleotide repeat, and DYS448 is a hexanucleotide repeat, while the 
remaining loci in the AmpFlSTR® Yfiler® PCR Amplification Kit are tetranucleotide 
repeats. Given that the AmpFlSTR® Yfiler® PCR Amplification Kit uses the same dye 
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chemistry as the AmpFlSTR® Identifiler® Plus PCR Amplification Kit, the 
GeneMapper® ID Analysis outlined in section 1.1 is similar to the GeneMapper® ID 
Analysis employed for Y-STR data analysis. 

 
1.3.1.4 Allele assignment occurs through the same 3-step process: 

1.3.1.4.1 Spectral separation still employs the 4 dyes incorporated during 
amplification (6-FAM™, VIC®, NED™, and PET®) as well as the GeneScan™ 500 
LIZ® Size Standard (PN 4322682) as the internal size standard.  Please refer 
to section 1.1 for more detail. 

1.3.1.4.2 Peak BP Sizing still uses GeneScan™ 500 LIZ® Size Standard (PN 4322682) as 
the internal size standard and the Local Southern Method for sizing of 
fragments of unknown length.  Please see section 1.1 for more detail.  The 
size standard chosen for GeneMapper analysis is be CE_G5_HID_GS500. 

 
1.3.1.5 Allele designations are still determined through comparison of peaks of unknown 

length to peaks of known lengths in the manufacturer-provided allelic ladder in the 
corresponding dye channel.  An allelic ladder must be present and interpretable in 
each run for comparison.  If multiple ladders were injected in a single run, 
GeneMapper averages samples labeled as “Allelic Ladder” during data analysis. If 
any ladders do not exhibit quality data, change the sample type from “Allelic 
Ladder” to “Sample” so they are not included in the software averaging of ladders. 

 
1.3.2 GeneMapper Procedure 

1.3.2.1 Exceptions to the GeneMapper analysis procedure outlined in section 1.1 include: 
1.3.2.1.1 Analysis Method: Yfiler 

• Bin Set: AmpFlSTR _Binset_v3X 
• The “use marker-specific stutter ratio if available” option must be selected  

1.3.2.1.2 Minus Stutter Distances: 
• Trimeric repeats: from 2.25 to 3.75 
• Tetrameric repeats: from 3.25 to 4.75 
• Pentameric Repeats: from 4.25 to 5.75 
• Hexameric Repeats: from 5.25 to 6.75 

 
1.3.2.1.3 Analysis range: Partial – the lower end of range should be adjusted to 

accommodate run conditions, but generally ranges from about 2,400 to 
10,000  

 
1.3.2.1.4 Sizing: Partial: 75 – 400 (450 is optional; largest peak approximately 335 bp 

at DYS392, so the 350 and 400 bp LIZ peaks permits the Local Southern Size 
Calling Method) 

 
1.3.2.1.5 Peak Amplitude (Analytical) Threshold: 65 RFUs (approximately 3 times the 

maximum observed peak height in the validation’s minimum threshold 
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study for 20 second injections (21 RFU in yellow dye channel; validation 
data show that the yellow and red dye channels tend to be the noisiest)). 

 
1.3.2.1.6 Panel: Yfiler_v1.2X 

 
1.3.2.2 After analysis, the data must be examined for the following: 
1.3.2.2.1 All of the following peaks are present, of good morphology, and of similar 

height in LIZ: 75, 100, 139, 150, 160, 200, floater (approximately 245-250), 300, 
340, 350, and 400 (the 450 peak is optional). 

 
Example of an acceptable Yfiler ILS: 

 
 
Example of an unacceptable Yfiler ILS: 

 
 

1.3.2.2.2 Correct and complete allelic designations on the allelic ladder chosen for 
analysis (see the AmpFlSTR® Yfiler® PCR Amplification Kit user manual). 
 

1.3.2.2.3 All positive control peaks are present and labeled correctly.  Any extraneous 
peaks must be attributable to a known biology-related or technology-related 
artifact.  Each amplification set and genetic analyzer run must have at least one 
acceptable positive control.  See the table above for the genotype of the male 
positive control (007). 
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1.3.2.2.4 All negative controls (amplification negative control and regent blanks) are free 
of allelic activity that cannot be attributed to a known biology-related or 
technology-related artifact.  Each reagent blank must have acceptable results 
for data from the corresponding extraction set to be used for interpretation.  
The amplification negative control must have acceptable results for data from 
the corresponding amplification set to be used.  Additionally, each analyzer run 
must have at least one acceptable negative control.  

 
1.3.2.2.5 Projects are named in the manner defined in section 1.1 or by using the LIMS 

generated 3130 plate number. 
 

1.3.2.2.6 Electropherograms must be examined for data quality and allele calls.  See the 
discussion below for guidance on evaluating data and editing artifacts and 
microvariant calls.  Verify that the allele edit comment is selected in the alleles 
tab of the plot window.  To change or delete the allele call, click on the peak or 
allele call to be edited to select it.  Right click and either choose Delete Allele or 
Rename Allele.  Explain your edit in the comment box. 
 

1.3.2.2.7 Upon completion of analysis, save the project.  With labels to include allele 
peak calls, allele peak heights, allele peak sizes, and allele edit comments (if 
applicable), print plots for all case samples and associated controls to be 
included in the case record.  Place in each case folder a printout of the 
complete GeneMapper project list for each run along with the plots for all 
associated controls and samples associated with that case.  If an entire run is 
not used, it is not necessary to print the plots. However, the injection list must 
be included in the case record with an explanation as to why data was not used 
(e.g., no acceptable positive control).  Document each time a sample is 
manipulated, such as longer or shorter injection times or if amplification 
product is diluted.   

 
1.3.2.2.7.1 When STR data for an extraction is not used for interpretation due to 

quality control issues, the case files must include, at a minimum, all 
associated examination documentation and a capillary 
electrophoresis grid for each injection.  
 

1.3.2.2.8 A second analyst must perform the GeneMapper analysis independently and 
agree with the allele calls reported by the first analyst on the allele chart by 
noting their second read on the injection list. By initialing and dating the 
injection list, the technical reviewer is agreeing with the allele calls, edits, and 
any manual calculations performed by the initial analyst.  

 
1.3.2.2.9 In order to import GeneMapper allele calls into the allele chart of LIMS reports:  
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• Select the case-specific samples to be exported in the sample tab (this must be 
performed for each case) 
• Go to Tools -> Report Manager 
• Ensure that LIMS Import Report is selected 
• Go to File -> Export 
• Save the file  
• Go to the allele chart panel in LIMS -> Import  
• Navigate to location of your saved GeneMapper export file->Open  
• Select Replace->OK to replace existing data or 
• Select Append->OK to add to existing table data 

 
1.3.2.2.10 Allele calls may also be manually entered into the LIMS allele chart panel. 

 
1.3.3 Y-STR Artifacts and Unusual Results 

1.3.3.1 Technology-related artifacts that are observed in Identifiler® Plus/GlobalFiler data 
analysis can be expected in Yfiler® data as well, given the same method of capillary 
electrophoresis used to obtain Identifiler® Plus/ GlobalFiler data is used to obtain 
Yfiler® data.  Please see section 1.1.2 for more detail artifacts commonly observed in 
STR analysis.   

1.3.3.2 Biology-related artifacts, or those that result from the PCR, include stutter products 
and incomplete 3’ (-A) nucleotide addition.  In addition to the -4 stutter often 
observed in tetranucleotide repeats, when performing Yfiler® data analysis, one 
must consider the possibly of -3 stutter of trinucleotide repeats, -5 stutter of 
pentanucleotide repeats, and -6 stutter of hexanucleotide repeats, though the 
increasing number of base pairs in a repeat unit is expected to correlate to a smaller 
ratio between the artefactual peak and the true peak from which it was created.  In 
addition to minus stutter, plus stutter or forward stutter should be considered a 
possibility when “extra” peaks are observed in an otherwise single-source sample 
that occurs in the plus stutter position (typically one repeat unit larger than the true 
allele).  Plus stutter occurs when polymerase slippage occurs during amplification 
that may lead to a loop forming in the synthesized strand (as opposed to in the 
template strand, as is suggested for minus stutter).  This loss of processivity may be 
attributable to critical components of PCR becoming limited or depleted in the later 
amplification cycles.  The internal Yfiler® validation data show that most plus stutter 
was less than 4% of the main allele peak height.  Samples that seemingly exhibit 
forward stutter must be interpreted with caution, so as not to misinterpret an 
actual mixture of male DNA. 

1.3.3.3 In addition to minus and plus stutter that is one full repeat unit smaller or larger 
than the true peak, DYS19 has demonstrated, both in the developmental validation 
and in the internal validation, the propensity for incomplete or partial stutter 
activity in both the -2 and +2 positions.  This may be attributable to the higher 
degree of secondary structure causing Taq to stall more frequently.  This locus was 
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probably retained in the European minimal haplotype for historical reasons, as was 
TH01 in the core loci used in autosomal analysis. 

Stutter  

Marker 
Developmental 

Validation % 
Stutter 

% bp stutter 
(plus or minus) 

Highest Observed % in 
Internal Validation, if 

Greater than Developmental 
Validation Data 

Stutter % Filters to 
be used at HFSC 

DYS456 13.21 - - 13.21 
DYS389I 11.79 - - 11.79 
DYS390 10.4 - 10.67 10.67 
DYS389II 13.85 - - 13.85 
DYS458 12.2 - 12.72* 12.2 
DYS19 11.04 10.21 (-2 bp) - 11.04(-4bp)/ 

10.2 (-2bp) 
DYS385a/b 13.9 - - 13.9 
DYS393 12.58 - - 12.58 
DYS391 11.62 - 14.26* 11.62 
DYS439 11.18 - - 11.18 
DYS635 10.75 - - 10.75 
DYS392 16.22 7.9 (+3 bp) - 16.22 (-4 bp)/ 

7.9 (+3 bp) 
Y GATA H4 11.08 - 13.86* 11.08 
DYS437 8.59 - - 8.59 
DYS438 4.28 - - 4.28 
DYS448 4.96 - - 4.96 

*Observed in a sample for which the RFU activity far exceeded the “sweet spot” of 1000-3000 RFUs; 
most alleles were >8000 RFUs (Non-probative #19, 10 seconds) 
 

1.3.3.4 Other artifacts, published or observed during internal validation: 
1.3.3.4.1 Published (observed in developmental validation): 

• ~88 bp in VIC® (green channel) 
• ~80 bp in NED™ (yellow channel) 
• ~95 bp in NED™ (yellow channel) 
• ~80 bp in PET® (red channel) 

 
1.3.3.4.2 Observed in internal validation: 

• ~95 bp in VIC® (green channel) 
• ~118 bp in VIC® (green channel) 
• ~98-100 bp in NED™ (yellow channel) (95 bp published artifact) 
• ~205 bp in PET® (red channel) 
• ~215 bp in PET® (red channel) 
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1.3.4 Microvariants 
1.3.4.1 Please see section 1.1.3 for additional information on and naming instructions of 

microvariants.  Given the inclusion of trinucleotide repeats, pentanucleotide 
repeats, and hexanucleotide repeats, along with tetranucleotide repeats in Yfiler®, 
one must consider the size of the repeat unit when assessing the possibility to 
microvariants (not just 4 bps as indicated in section 1.1.3).  To ensure that a 
microvariant is truly off-ladder and not just the result of electrophoretic drift, 
suspected microvariants must be re-injected for confirmation, with one exception.  
If the microvariant appears in multiple evidence samples from the same case 
otherwise having the same Y-STR profile, it is not necessary to re-inject.  Because 
every measure shall be taken to interpret evidence samples prior to reference 
samples, the presence of a microvariant in an associated known sample does not 
suffice for confirmation, as the evidence is interpreted before and separate from 
any associated knowns in the case.   

 
1.3.5 Y-STR Re-analysis and Additional Analysis 

1.3.5.1 Please see section 1.1.4 for more detail.  The steps taken to investigate 
unacceptable controls, to optimize data, and to resolve artifacts that may interfere 
with allelic designations when performing Identifiler® Plus data analysis are also 
employed accordingly with Yfiler® data analysis. 

 
1.3.6 Y-STR Interpretation Guidelines 

1.3.6.1 Given Y chromosome markers are passed down from generation to generation 
without changing (except for mutational events), a match between an evidentiary 
item and a known sample only suggests that the individual could have contributed 
to the evidentiary sample, along with any relative from his paternal lineage.  A 
match could also result from unrelated individuals. As with autosomal analysis, 
mutations must be considered in comparisons that include multiple generations 
(e.g., alleged father and product of conception).  

 
1.3.6.2 Results and conclusions from DNA analysis must be scientifically supported by the 

analytical data with appropriate standards and controls.  Interpretations are made 
as objectively as possible and consistently from analyst to analyst.  Not every 
situation can nor should be covered by a specific rule and situations may occur that 
require an analyst to deviate from stated guidelines.  Expectations of alleles per 
locus and major/minor ratios are stated below.  It is expected that limited variance 
from these values may occur.  Analysts shall utilize their training and experience to 
address these variances.  Both the reporting analyst and reviewer shall agree on all 
variances that are accepted.  If an agreement between the reporting analyst and 
reviewer cannot be reached, consultation with a more experienced analyst or 
supervisor may help.  If an agreement is still not reached, it shall be brought to the 
attention and decision of the Technical Leader.  Case documentation including, but 



      Biology/DNA  
DNA Interpretation SOP 

Biology/DNA Division 
  
 

 
DNA Interpretation SOP Document ID: 25414 
Issued By: Section Technical Leader  Issue Date: September 10, 2018 
Uncontrolled When Printed Page 46 of 61 
 

not limited to any and all assumptions, must be sufficient for another experienced 
analyst to identify and understand the deviation from stated guidelines.    

 
 

1.3.7 Types of Conclusions 
1.3.7.1 Three types of conclusions are generally possible when both evidence (questioned) 

and reference (known) samples are tested and compared:  
1.3.7.1.1 Inclusion/cannot be excluded: the individual could have contributed 

to/been a source of the questioned profile;  
 

1.3.7.1.2 exclusion: the individual could not have contributed to/been a source of the 
questioned profile; the genotype comparison shows profile differences that 
can only be explained by the two samples originating from different sources 

 
1.3.7.1.3 inconclusive: the data does not support a conclusion; insufficient 

information exists to support any conclusion.  The reason for inconclusive 
results must be clearly stated in the report. 

 
1.3.7.1.4 Inclusion or exclusion is determined by qualitative and quantitative 

evaluation of the entire DNA profile produced at the various loci tested.  
Inconclusive results or an uninterpretable profile may result from but are 
not limited to: 

 
• Insufficient amounts of template DNA 
• Degradation, inhibitors, or data of otherwise poor quality 
• Mixtures of DNA from multiple donors 
• Data that does not meet quality assurance guidelines 

 
It may be acceptable for an inclusion or exclusion to be determined when one 
or more loci yield inconclusive results.  An inclusion statement and any 
resulting statistical calculations are to be based only on loci that yield 
conclusive results.  An exclusion statement can be determined if even a single 
locus produces exclusionary results.  However, an exclusion shall not be 
determined if technical issues such as the loss of an allele due to incomplete 
(preferential) amplification, stochastic effects, mutation, or other factors may 
have caused the non-match.  

 
1.3.7.2 Types of Profiles 

1.3.7.2.1 A number of different types of profiles may be obtained from evidence samples.  
The comparisons with references that can be made are determined by the type of 
profile. 
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1.3.7.2.2 No profile: No DNA results obtained at all.  No comparison can be made to 
reference samples. 

 
1.3.7.2.3 Uninterpretable: Data obtained but insufficient for comparison.  This may be due 

to data at too few loci, data below the stochastic threshold, or when the overall 
quality of the data is questionable.  No comparison can be made to reference 
samples. 

 
1.3.7.2.4 Single source profile:  Unlike with autosomal analysis, because of the haplotype 

(combination of allelic states of a set of polymorphic markers lying on the same 
DNA molecule) nature of Y-STR analysis, a sample is considered single-source when 
not more than one peak (as opposed to two in autosomal analysis) is observed at 
any of the loci, except for DYS385 a/b. 

 
DYS385 a/b is a duplicated (or multi-copy) marker in which one primer binds at two 
separate locations on the Y chromosome.  The duplicated regions are 40,775 bp 
apart and facing away from one another.  If the locus is duplicated exactly, only one 
allele is observed at this marker.  However, it is very common to see two alleles at 
this locus.  This makes this marker very informative, which made it an ideal 
selection for inclusion in the European minimal haplotype.  Two alleles at DYS385 
a/b but only one allele at all other loci should not be interpreted as a mixture of 
DNA.  Duplicate repeats should be typed as a genotype (e.g. DYS385 – 11, 14; 16, 
16).  The order that the alleles are listed (typically from the smallest to the largest) 
does not imply assignation to one or the other of the two alternative chromosomal 
locations.10  Most duplications result in alleles that differ in size by 1 repeat unit.10 

Based on validation data, a stochastic threshold of 300 RFU can be applied to 
DYS385 a/b.  If a single allele is detected below 300 RFU, then the locus may not be 
used for statistics and should be interpreted with caution. 

 
Unlike DYS385 a/b which is two separate locations, DYS389 I and DYS389 II (DYS389 
I/II) are actually a single region, but produce two PCR products because the forward 
primer binds twice.  DYS389 II represents the fragment that results from the 
forward primer binding further away from the reverse primer.  It is longer than  
DYS389 I, occurring from about 250 bp to 295 bp, in the blue channel.  The 
fragment that is assigned to the DYS389 I locus results from the forward primer 
that binds nearer the reverse primer.  This fragment is generally about 140 bp to 
165 bp, also occurring in the blue channel. 

 
It is possible to observe multiple peaks at loci other than DYS385 a/b in a single-
source sample.  This is likely the result of the entire region of the Y-chromosome 
being duplicated and then diverging.  Peak heights are expected to be similar and 
peaks are expected to be no more than one repeat unit apart.  A duplication event 
on the Y-chromosome is considered when a sample is seemingly single-source but 
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some loci have two alleles, especially when loci are located near one another.  
However, this is not expected to be a common event.  As with any sample 
exhibiting more than one peak at a locus other than DYS385 a/b, extreme caution 
must be exercised during interpretation to ensure actual mixtures of male DNA are 
not mistaken for singles-source male DNA.  DYS437, DYS439, and DYS389I/II are 
closely spaced, as are DYS391, DYS439, and DYS635.10 

 
1.3.7.2.5 Mixtures: Evidence samples may contain DNA from more than one individual. A 

mixture can consist of full and/or partial profiles from multiple individuals.  
Generally, a sample is considered to have originated from more than one male 
individual if two or more alleles are present at two or more single-copy loci. Like 
autosomal analysis, allelic balance and excessive stutter may be used for 
consideration when assessing the number of contributors to a DNA profile.  Also 
like autosomal analysis, Yfiler® mixtures can be of two general types: mixtures with 
major/minor contributors and mixtures with indistinguishable contributors 
(unresolved). 

 
• Mixtures with major/minor contributors 

o The internal validation demonstrated that as the contribution of DNA in a mixture from the 
donors becomes more similar (e.g. approaches 1:2), it becomes more difficult to distinguish 
the profiles of the major and minor contributors.  Conversely, as the amount of DNA 
contributed becomes more dissimilar (e.g. approaches 1:19), the ability to distinguish 
contributors is improved.  Validation data indicate that at about a 1:4 ratio the individual 
contributors can be readily discerned from one another.  It is expected that minor peak 
heights can be ~35% or less than the height of the major peak.   

 
o Consideration must be given to the possibility of the “swapping” of the major and minor 

contributors should one of the components exhibit evidence of degradation.  If the major 
component is degraded, what appears to be from the major contributor at the loci of 
shorter fragments could appear to be from the minor component at the loci of longer 
fragments. 

 
 For mixtures in which minor contributors are determined to be present, a peak in 

stutter position (generally n-4) may be determined to be 1) a stutter peak, 2) an 
allelic peak, or 3) indistinguishable as being either an allele or stutter peak.  This 
determination is based principally on the height of the peak in the stutter position 
and its relationship to the stutter percentage expectations established by the 
laboratory.  Generally, when the height of a peak in stutter position exceeds the 
laboratory’s stutter expectation for a given locus, that peak is consistent with being 
of allelic origin and is designated as an allele.  If a peak is at or below this 
expectation, it is generally designated as a stutter peak.  However, it should also be 
considered as a possible allelic peak, particularly if the peak height of the potential 
stutter peak(s) is consistent with (or greater than) the heights observed for any 
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allelic peaks that are conclusively attributed (i.e., peaks in non-stutter positions) to 
the minor contributor(s). 

 
• Mixtures with indistinguishable contributors (unresolved) 

o Given the mode of inheritance of DNA specific to the Y chromosome, the product rule 
cannot be employed in statistical analysis.  Y-STR data is completely linked.  For this reason, 
the counting method is used to provide an estimated frequency of a particular haplotype.  A 
database is observed for the presence of the haplotype and the number of times it is 
observed is counted.  At this time, there is no consensus of Y-STR mixture interpretation in 
the forensic community.  Without the ability to provide significance or weight (statistics) to 
a Y-STR mixture, possible inclusions in a Y-STR mixture in which contributors cannot be 
distinguished shall not be reported.  Individuals can be excluded from an indistinguishable 
mixture when a finite number of contributors can be assessed.   

 
 Minimum Number of Contributors 

o Generally, the counting of all alleles at the locus that exhibits the greatest number of allelic 
peaks may provide guidance towards determining the minimum or finite number of 
contributors.  Proceed with caution when only one allele in the entire sample would lead to an 
increased number of possible contributors as stutter and peak imbalance can complicate 
mixture interpretation.   

 
o While counting allele peaks is very useful in determining a minimum number of contributors, 

the analyst must also consider allele sharing between individuals and allelic dropout may result 
in an underestimate of the actual number of contributors.  For this reason, mixtures may be 
reported as being from “at least” the fewest number of individuals possible, given the maximum 
number of alleles detected at a locus. 

 
 Partial profiles: Partial profiles exhibit allelic dropout in some, but not all, loci tested and can result 

from insufficient, degraded, or inhibited DNA.  Typically, smaller loci amplify better under these 
conditions and larger loci tend to drop out.   Care must be taken to ensure that non-matches are not 
a result of drop-out.   For partial profiles, the determination of which alleles/loci are suitable for 
comparison and statistical analysis should be made prior to comparison to the known profiles. 

 
1.3.7.3 Female Control DNA 

1.3.7.3.1 The female control DNA sample provided in the AmpFlSTR® Yfiler® Plus PCR 
Amplification Kit may be used in an amplification, but is not required.  Both 
developmental and internal validations established that not only is female 
DNA not amplified when primers from the AmpFlSTR® Yfiler® Plus PCR 
Amplification Kit are applied, but moreover, even in the presence of 
excessive female DNA (100-fold excess), male DNA can still be successfully 
amplified, electrophoresed, and typed using the AmpFlSTR® Yfiler® Plus PCR 
Amplification Kit.  Successful typing of the male control DNA (007) 
demonstrates successful PCR and subsequently successful allelic labeling by 
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the GeneMapper® ID software.  The amplification negative control, when it 
fails to produce allelic activity that cannot be attributed to biology-related 
or technology-related artifacts, demonstrates that amplification kit 
components were free of DNA prior to use on the associated samples. 

 
1.4 References: 

  
(1) User Bulletin GeneMapper® ID Software v3.2.1 Patch, ©2007; PN 4382255 Rev. A 

 
(2) GeneMapper™ ID Software Version 3.1 Human Identification Analysis User Guide, ©2003; PN 

4338775 Rev. C 
 

(3) Butler, John M.  Fundamentals of Forensic DNA Typing.   San Diego: Academic Press, 2010. 
 

(4) SWGDAM Interpretation Guidelines for Autosomal STR Typing by Forensic DNA Testing 
Laboratories, Approved 1/14/10. 
 

(5) Coble, M. and Butler, J. (September 2011) “Exploring the Capabilities of Mixture Interpretation 
Using True Allele Software”.  24th Congress of the International Society for Forensic Genetics, 
Vienna, Austria.http://www.cstl.nist.gov/strbase/pub_pres/ISFG2011-Coble-TrueAllele.pdf 
 

(6)  SWGDAM Interpretation Guidelines for Y-Chromosome STR Typing, Approved 1/9/14. 
 

(7)  Houston Forensic Science Center Validation of the GlobalFiler® PCR Amplification Kit using the 
3500XL Genetic Analyzer Validation Binders 1 and 2. 

 
(8)  Houston Forensic Science Center Validation of the Yfiler® Plus PCR Amplification Kit using the 

3500XL Genetic Analyzer Validation Binders 1 and 2. 
 

(9)  Butler, John M.  Advanced Topics in Forensic DNA Typing: Interpretation.   San Diego: Academic 
Press, 2015. 
 

(10)  SWGDAM Interpretation Guidelines for Autosomal STR Typing by Forensic DNA Testing 
Laboratories, Approved January 12, 2017. 
 

 
 
 
 
 
 
 
 

http://www.cstl.nist.gov/strbase/pub_pres/ISFG2011-Coble-TrueAllele.pdf
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2 Statistics 
 
• Once a match has been identified and an individual included as a possible source of evidentiary 

material, the significance of that match is estimated to allow investigators, the legal sector, and 
ultimately a jury of lay persons to place the appropriate emphasis on the conclusion.  Although 
every locus analyzed is evaluated, some loci may provide no information with regard to a particular 
comparison.  Because it is the significance of the match that is important, only the matching loci can 
be taken into account in estimating significance and only after the analyst has determined that the 
profiles match.  The different methods of calculating significance, when each is to be applied, and 
the population data from which they are calculated are addressed in this protocol.  

 
• Significance estimates must be presented in the report for all probative matches.  Significance 

estimates are not required for non-probative matches. Non-probative matches may be those from 
intimate samples or a reasonably assumed contributor (see section 1.1.5.3).   

 
• The laboratory must perform statistical analysis in support of any inclusion, other than for non-

probative matches, regardless of the number of alleles detected and the quantitative value of the 
statistical analysis.  If an individual cannot be excluded but statistics cannot be performed (due to 
stochastic issues), no conclusions can be rendered for that particular individual. 

 
• For all estimates, statistical significance is expressed as an inverse probability of inclusion.   

 
• The interpretation of the evidentiary profile should determine the statistical approach used. It is 

inappropriate to make inclusions or exclusions based on the statistical approach without first 
considering the interpretation of the profile. 

 
• “Such estimates of the frequency of a particular profile in a population are, of course, subject to 

uncertainty.  Even moderate -sized DNA databases (drawn from samples of several hundred 
persons) are subject to statistical uncertainty, and in smaller ones, the uncertainty is greater.  In 
addition, the database might not properly represent the population that is relevant to a particular 
case.  Finally, the assumptions of HW [Hardy-Weinberg] and LE [linkage equilibrium], although 
reasonable approximations for most populations, are not exact …we believe that it is safe to assume 
that the uncertainty of a profile frequency calculated by our procedures from adequate databases 
(at least several hundred persons) is less than a factor of about 10 in either direction.”(10, p. 27) 

 
2.1 Stochastic Threshold   

2.1.1 The stochastic threshold is the “RFU value above which it is reasonable to assume that, 
at a given locus, allelic dropout of a sister allele has not occurred1”.  The validation data 
support a stochastic threshold for Identifiler Plus samples of 200 RFUs using a 5 or 10 
second injection and a stochastic threshold for GlobalFiler samples of 500 RFUs (except 
Y Indel and DYS391 which do not have established stochastic thresholds).  Analysts must 
use caution when activity is observed below the analytical threshold, even though all 
labeled activity is above the stochastic threshold.  It may be appropriate to exclude the 
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locus from statistical analyses.  Due to the possibility of allelic drop-out, it may not be 
appropriate to perform a ratio calculation between major and minor components, given 
the minor component may not be fully represented. 

2.1.2 References are expected to be single-source.  When the data supports that a reference 
profile is single-source, it is permissible to use evidentiary data that satisfies stochastic 
threshold criteria even though the reference may not satisfy stochastic threshold 
criteria at all loci. 

 
2.2 Single source significance calculation 

2.2.1 The random match probability (RMP) is an estimate of the rarity of the observed DNA 
profile of a single individual, or the chance that a randomly selected individual from a 
population has an identical STR profile or combination of genotypes at the DNA markers 
used.6 

2.2.1.1 Random match probability can be applied if the evidentiary profile is determined to 
be any of the following: 

• Single source  
• Major component of a mixture with one contributor 
• Deduced component of an intimate mixture  
• Obligate minor component of a two person mixture 

2.2.1.2 RMP is suitable for genotypes that are attributed to a single individual.   
2.2.2 The following formulae from NRC II Recommendation is used: 

2.2.2.1 For heterozygotes: 
• f = 2pq (NRC II formula 4.1b). 

2.2.2.2 For loci where the genotype is clearly identified as homozygous 
• f = p2 + p (1-p)θ  where θ = 0.01 (NRC II formula 4.4a).  
• Population substructure is taken into account with the theta correction  
• θ = 0.01 is a reliable and conservative estimate of population substructure, but 
case-specific reasons may warrant the adoption of a higher value 

2.2.2.3 For loci where the genotype is ambiguous as homozygous or heterozygous:   
• f=2p-p2  
• When this option is used it must be selected in the PopStats for each locus 

that it applies to.  Check the box that says Rec 4.1 for each locus. 
2.2.2.4 Assuming Hardy-Weinberg and linkage equilibrium, the expected proportion of a 

specific genetic profile is computed by calculating the genotype frequencies at each 
locus and multiplying them, using the product rule. (10) 

2.2.2.5 Popstats shall be used to calculate the RMP on a “Forensic Single Sample”.  The 
“Broward Report” shall be printed and included in the case file. 

 
2.3 Mixed source significance calculation 

2.3.1 The combined probability of inclusion (CPI) is a probability of what fraction of the 
population would be included as a contributor to a DNA mixture.   



      Biology/DNA  
DNA Interpretation SOP 

Biology/DNA Division 
  
 

 
DNA Interpretation SOP Document ID: 25414 
Issued By: Section Technical Leader  Issue Date: September 10, 2018 
Uncontrolled When Printed Page 53 of 61 
 

2.3.2 For the frequency of each locus, Probability of Inclusion (PI) = (p1 + p2 + p3 + p4 +… + 
pk)2 where p is the estimated frequency of the allele detected for each allele 1 through 
k, and k is the number of alleles detected at the locus. 

2.3.3 However, PopStats is configured to use Theta in the Probability of Exclusion/Inclusion 
Calculations: 

2.3.3.1 PI = (p1 + p2 + p3 + p4 +… + pk)2 + θ(p1(1- p1)+ p2(1- p2) + p3(1- p3) + p4(1- p4) +… + 
pk(1- pk), where θ = 0.01. 

2.3.4 For all loci used to identify the match, CPI = (PI1 x PI2 x PI3 x PI4 x… x PIk), where k is the 
number of loci, assuming Hardy-Weinberg and linkage equilibrium. 

2.3.5 CPE (combined probability of exclusion) = 1 – CPI 
2.3.6 The CPI calculation does not take into account the number of contributors.  It is suitable 

for samples with either a finite number of contributors or those with an at least 
designation. 

2.3.7 The main principle of the mixture calculation is to use loci where dropout is unlikely.  
Only loci with the data from all contributors may be calculated. Use of partial data that 
excludes some alleles, such as a major component that is a mixture, is permissible. 

2.3.8 If a finite number of contributors is not determined for a mixture, then extreme caution 
must be used to ensure that loci where dropout could have occurred are not used in the 
CPI calculation 

2.3.9 The following process can aid in determining appropriate loci for mixture calculation 
2.3.9.1 Exclude loci as follows: 

2.3.9.1.1 Identifiler Plus or GlobalFiler loci with alleles below the stochastic threshold.  
2.3.9.1.2 Identifiler Plus or GlobalFiler loci where data is observed below analytical 

threshold. Caution must be exercised in distinguishing baseline from 
potential allelic activity. 

2.3.9.1.3 Identifiler Plus or GlobalFiler loci where other loci suggest there could be 
alleles below stochastic threshold 

2.3.9.2 Loci may be re-instated as follows: 
2.3.9.2.1 Mixtures with an assumption of finite number of contributors where all data 

is observed (i.e. four alleles are present or one major and two minor alleles) 
2.3.10 Allele sharing/stacking of alleles due to sharing creates more uncertainty.4   An allele 

may ultimately exceed the stochastic threshold due to the stacking of a true allele with 
another true allele, or a true allele with an artifact such as stutter.  In these instances, 
the analyst should consider excluding the locus from statistical analysis, despite all 
alleles exceeding the stochastic threshold.  The reason for excluding a locus that is 
otherwise acceptable must be documented in the case record.  

2.3.11 Mixture calculations may not be performed on mixtures believed to contain DNA from 
related individuals as the calculation assumes unrelated individuals.  Indistinguishable 
mixtures of related individuals may be reported as inconclusive if a statistical analysis is 
not possible to support the inclusion. 

2.3.12 Popstats shall be used to calculate the CPI on a “Forensic Mixture”.  The “Probability of 
Inclusion (Short)” Report shall be printed and included in the case file. 
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2.4 Interpretation of Potential Stutter Peaks in a Mixed Sample1  

2.4.1 For mixtures in which minor contributors are determined to be present, a peak in 
stutter position (generally n-4) may be determined to be 1) a stutter peak, 2) an allelic 
peak, or 3) indistinguishable as being either an allele or stutter peak.  This determination 
is based principally on the height of the peak in the stutter position and its relationship 
to the stutter percentage expectations established by the laboratory.  Generally, when 
the height of a peak in stutter position exceeds the laboratory’s stutter expectation for a 
given locus, that peak is consistent with being of allelic origin and is be designated as an 
allele.  If a peak is at or below this expectation, it is generally designated as a stutter 
peak.  However, it should also be considered as a possible allelic peak, particularly if the 
peak height of the potential stutter peak(s) is consistent with (or greater than) the 
heights observed for any allelic peaks that are conclusively attributed (i.e., peaks in non-
stutter positions) to the minor contributor(s). 

2.4.1.1 If filtered minor peaks could be attributed to the minor component, then the locus 
must be excluded from the CPI calculation.   

2.4.1.2 It is not advisable to use the peak heights of alleles conclusively attributed to a 
second or third contributor at larger loci to determine whether a peak(s) at smaller 
loci may be filtered stutter, particularly if degradation is suspected.   

 
2.5 Minimum and null allele frequencies 

2.5.1 Following NRC II recommendations, minimum allele frequencies are calculated using 
5/2N where N is the number of individuals in the population database and null allele 
frequencies are set to 0. 

 
 

2.6 Off-ladder alleles 
2.6.1 Off-ladder alleles that have been confirmed by re-injection (in the case of STR analysis) 

or appearance in more than one sample are used to determine a match and estimate 
the significance of that match. The allele frequency is the calculated minimum allele 
frequency for that locus and population group if not contained in the database. 

 
2.7 Software 

2.7.1 The latest available and installable version of the FBI’s PopStats software is configured 
to use the above formulae and used to calculate significance estimates. The Forensic-
Single Sample data input option is used for single source significance calculations. The 
Forensic Mixture Case data input option and the Mixture Formula is used for mixed 
source significance calculations. 

2.7.2 In PopStats2: 
2.7.2.1 For significance estimates calculated after Service Pack #7 (SP7) upgrade on January 

6, 2017:  PopStats is configured to use the NIST database.8  NIST determined the 
genotypes and allele frequencies for a total of 1036 unrelated U.S. population 
samples using 29 autosomal short tandem repeat (STR) loci that are available in 
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commercial STR multiplex kits including D1S1656, D2S441, D2S1338, D3S1358, 
D5S818, D6S1043, D7S820, D8S1179, D10S1248, D12S391, D13S317, D16S539, 
D18S51, D19S433, D21S11, D22S1045, CSF1PO, F13A01, F13B, FESFPS, FGA, LPL, 
Penta C, Penta D, Penta E, SE33, TH01, TPOX, and vWA.  

 
The genotypes are listed for the full set (n = 1036) of samples and are also separated by 
each population group: African American (n = 342), Caucasian (n = 361), Hispanic (n = 236), 
and Asian (n = 97). 
 
2.7.2.2 For significance estimates calculated prior to the SP7 upgrade: PopStats was 

configured to use the African American (Blk), U.S. Caucasian (Cau), Hispanic (SWH) 
databases for the 13 core STR loci that were created from data developed by the FBI 
Forensic Science Research Unit in Quantico, VA.  The data are published in the 
Journal of Forensic Sciences under the title "Population Data on the Thirteen CODIS 
Core Short Tandem Repeat Loci in African Americans, U.S. Caucasians, Hispanics, 
Bahamians, Jamaicans, and Trinidadians", by Bruce Budowle, Ph.D., Tamyra R. 
Moretti, Ph.D., Anne L. Baumstark, B.S., Debra A. Defenbaugh, B.S., and Kathleen M. 
Keys, B.S. (J. of Forensic Sci., 1999; 44(6):1277-1286). 

2.7.2.2.1 The African American (Blk), U.S. Caucasian (Cau), Hispanic (SWH), Chamorro, 
and Filipino databases for D2S1338 and D19S433 were copied from Table 1 
and Table 2 of "Population Data on the STR Loci D2S1338 and D19S433" by 
Bruce Budowle, Patrick J. Collins, Pero Dimsoski, Constance K. Ganong, Lori 
K. Hennessy, Craig S. Leibelt, Sulekha Rao-Coticone, Farideh Shadravan, and 
Dennis J. Reeder; Forensic Science Communications, July 2001, Volume 3, 
Number 3.   

2.7.2.2.2 An erratum was issued in June 2015 correcting some of the data sets listed 
above.  This erratum was necessary since a comparison of the previous data 
with new STR kits revealed some discrepancies.  As stated in the erratum, 
these differences were attributed to “human error, typically due to the 
limited software capabilities for genotyping with manual data editing and 
recording, and (ii) technological limitations (e.g., insufficient resolution for 
distinguishing microvariants by polyacrylamide gel electrophoresis).”  
Moretti, T. R., Budowle, B. and Buckleton, J. S. (2015), Erratum. J Forensic 
Sci, 60: 1114–1116. doi:10.1111/1556-4029.12806 

2.7.2.2.3 Population data for other racial groups are available within PopStats as part 
of published data from the Journal of Forensic Science under the title 
“CODIS STR Loci Data from 41 Sample Populations” by Budowle, et. al, (J. 
Forensic Sci. 2001;46(3):453-489). 

 
2.8 Significance Estimation for Forensic Parentage and Relationship Cases 

2.8.1 This section refers to paternity calculations, as the vast majority of cases involve 
questions of the paternity of a child.  However, the same statistical approach and 
formulas can be used in significance estimations in maternity cases.  
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2.8.2 Formulas for Paternity Index Calculations 
2.8.2.1 Capital letters refer to the allele(s) present in each individual tested and small 

letters refer to the frequency of the allele(s). 
 

M C AF PI 
BD AB AC 1/2a 
BC AB AC 1/2a 
BC AB AB 1/2a 
BC AB A 1/a 
B AB AC 1/2a 
B AB AB 1/2a 
B AB A 1/a 
AB AB AC 1/ [2(a+b)] 
AB AB AB 1/ (a+b) 
AB AB A 1/ (a+b) 
AB A AC 1/2a 
AB A AB 1/2a 
AB A A 1/a 
A A AB 1/2a 
A A A 1/a 
Unknown AB AC 1/4a 
Unknown AB AB (a+b)/4ab 
Unknown AB A 1/2a 
Unknown A AC 1/2a 
Unknown A A 1/a 

 
2.8.2.2 The Combined Paternity Index (CPI) is calculated by multiplying these individual PIs.  

The Probability of Paternity is to be calculated, using the formula below, which 
assumes a prior probability of 50%: 

2.8.2.3 Probability of paternity = (CPI/(CPI +1)) X 100 
2.8.2.4 When a mismatch occurs, PI = µ/PEx, µ is the general locus mutation rate and PEx is 

the average probability of exclusion for the locus.7 
 

2.9 Significance Estimation for Y-STR Samples3 
2.9.1 Y-STR loci are located on the nonrecombining part of the Y-chromosome and, therefore, 

considered linked as a single locus. A haplotype is a set of DNA variations, or 
polymorphisms, that tend to be inherited together. A haplotype can refer to a 
combination of alleles or to a set of single nucleotide polymorphisms (SNPs) found on 
the same chromosome.  A Y-STR database must consist of haplotype frequencies rather 
than allele frequencies.  Haplotype frequencies are estimated using the counting 
method, which involves searching a given haplotype against a database to determine 
the number of times the haplotype was observed in that database.  The frequency of 
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the haplotype in the database is then estimated by dividing the count by the number of 
haplotypes searched.5 

2.9.2 A Y-STR profile probability can be estimated from the observed haplotype frequency by 
attaching a confidence interval (95%) to the haplotype frequency estimate to capture 
the effect of the database size.  The sampling variance of the profile probability 
decreases as the database size increases.5  The profile probability is not the same as the 
match probability, which is the probability of observing a profile given that it has already 
been observed and depends on the evolutionary history of the population. 5   

2.9.3 The Y haplotype frequency (p) is calculated using the p = x/N formula, where x = the 
number of times the haplotype is observed in a database containing N number of 
haplotypes.   

2.9.4 A consolidated U.S. Y-STR database (http://usystrdatabase.org) has been established 
and is used for population frequency estimation.  At usystrdatabase.org, you may select 
the STR kit being used for loci rearrangement and easier data input.  You may also select 
the ancestries you wish to search.  For each locus that is used statistically, select the 
allele(s) from the drop-down menu or manually enter alleles in the appropriate cell.  
Select search. 

2.9.5 Tabular results display: 
• the ancestries selected 
• number of haplotypes in database having data for the selected loci 
• number of haplotypes in the database matching the entered haplotype 
• the haplotype frequency 
• frequency upper bound (95%, profile probability is estimated by applying a 95% 
confidence upper bound to the haplotype frequency, using the method described by 
Clopper and Pearson (1934)) 
• theta (is based on the number of loci used), and  
• the match probability (calculated using the formula Pr(A│A) = θ + (1 – θ) pA, where A 
is the haplotype of interest and Pr(A│A) is the probability of observing haplotype A given 
that it has already been seen once in another individual of the same subpopulation. pA 
is the profile probability which can be estimated by the counting method, with sampling 
uncertainty being accommodated by using the upper confidence limit for the estimate 
of pA.) 

o a match probability of 0.001 means that there is a 1 in 1,000 chance of randomly 
selecting a second individual with this profile, given it has already been observed 
once 
o when the evidence profile is considered to be single-source, the inverse of the 
match probability is the likelihood ratio; for example, a match probability of 0.001 
means that the DNA match is 1000 times more likely to occur if the reference 
individual (or a paternal relative) is the contributor than if the source of the evidence 
is a randomly selected individual from the same population   

2.9.6 Blue links under “Number of Haplotypes (with Selected Alleles)” gives a pop-up listing of 
haplotype searched and matching haplotypes from database.  

http://usystrdatabase.org/
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2.9.7 All races within the website must be searched and reported.  The database name and 
access date shall be reported.  Any reported database searches must be included in the 
case record.  Statistics shall not be performed with fewer than 5 loci. 

 
2.10 References: 

 
(1) SWGDAM Interpretation Guidelines for Autosomal STR Typing by Forensic DNA Testing 

Laboratories, Approved 1/14/10. 
 

(2) CODIS 7.0 PopStats 
 

(3) Ballantyne, J.  (March 2011).  “Interpretation of Y STR Mixtures and Statistical Applications”.  
Presentation at the NFSTC DNA Mixture Interpretation Conference, Largo, FL. 

 
(4) Coble, M. and Butler, J. (September 2011) “Exploring the Capabilities of Mixture Interpretation 

Using True Allele Software”.  24th Congress of the International Society for Forensic Genetics, 
Vienna, Austria.http://www.cstl.nist.gov/strbase/pub_pres/ISFG2011-Coble-TrueAllele.pdf 
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Press, 2015. 
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3 Reports 
 

3.1 The goal of DNA analysis is to determine whether a particular person is or is not the source of an 
item of biological evidence.  To accomplish this goal, DNA profiles must be generated for the 
evidentiary item and for a reference item so that the two DNA profiles can be compared.  When 
profiles are compared, they may match, differ, or lack information to where a result cannot be 
interpreted.  DNA results are issued to the requestor via a DNA report.  For some DNA requests 
a comparison cannot be made because no reference samples are available.  In those instances, 
the DNA report only provides the DNA results of evidentiary items. 

 
3.2 Conclusions made by the analyst must be supported by case notes and other documentation 

generated during the analysis process, which are maintained either in hard copy or 
electronically. The DNA report must communicate both analytical results and conclusions of the 
analyst conveying the essence of what he or she would say if asked for an expert opinion in 
court. The DNA report informs counsel during discovery what physical evidence was examined 
and what its significance may be.  Decisions may be made by police officers, attorneys, and the 
courts based on the report alone without analyst clarification, so the report must be able to 
stand alone.  Therefore, it is important to understand the significance of any DNA result. Case 
information, analysis results, and reports are only released to authorized individuals according 
to Houston Forensic Science Center (HFSC) Quality Manual requirements. 

 
3.3 The report must contain the information required in the Quality Manual and the FBI Quality 

Assurance Standards (QAS).  Specifically, the QAS requires the following: case identifier, 
description of evidence examined, results and/or conclusions, a qualitative or quantitative 
interpretive statement, date issued, and signature and title of the responsible person. In 
addition, QAS requires the following in each DNA report: 

 
• Description of DNA technology 
• Loci analyzed, if DNA analyzed or the name of kit utilized for testing 
• Disposition of evidence 

 
3.4 All samples retained in the screening report and/or received by the technicians/analyst shall be 

listed in the report.  For each sample, report the results obtained or indicate that no analysis 
was performed.  The general types of results are:  
3.4.1 A general statement about the profile or if results were not interpretable 

3.4.1.1 Whether the profile obtained is from a single source or mixture of DNA. 
3.4.1.2 For mixtures, this includes the minimum number of contributors and whether a 

male is present. 
3.4.2 For mixtures, statements must be included if any of the following apply: 

3.4.2.1 If components can be distinguished (i.e. major/minor/trace)  
3.4.2.2 A finite number of contributors is assumed 
3.4.2.3 If a known contributor is assumed as part of a mixture  
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3.4.2.4 If a foreign DNA profile is deduced 
3.4.3 All tested/known individuals shall be compared to all evidentiary results included in a 

DNA report.  If appropriate, previously unsourced evidentiary profiles should be 
compared to additional references that may be submitted in a case.  And likewise, 
unsourced evidentiary profiles tested in subsequent testing should be compared to 
previously reported references in a case.  Note, however, that sometimes the results are 
inconclusive as to whether an individual can be excluded, but the inconclusive nature of 
that comparison shall still be included in the report. 

3.4.4 The statistical significance of a “not excluded” or “inclusionary” result:  
3.4.4.1 For autosomal analysis, this is reported either for all searched races, or for the 

lowest, most common probability calculated.  (eg, 1) The probability that a 
randomly chosen unrelated individual would be included as a possible contributor 
to this foreign male DNA profile is approximately 1 in 10 nonillion for Caucasians, 1 
in 630 nonillion for African Americans, 1 in 22 nonillion for Hispanics, and 1 in 19 
nonillion for Asians. or 2) The probability that a randomly chosen unrelated 
individual would be included as a possible contributor to this foreign male DNA 
profile is approximately 1 in 10 nonillion individuals.)  Statistics are reported to two 
significant digits.  If all loci are not used in the statistical calculation, the loci used 
must be noted in the report.   

3.4.4.2 For parentage cases, the combined paternity index is reported for all searched 
races.  Both the CPI and Probability of Paternity are reported to two significant 
digits. 

3.4.4.3 For Y-STR cases, all races searched shall be reported statistically, along with the 
database used for analysis and the date of the database search.  The following 
information generated by http://usystrdatabase.org is reported: 

3.4.4.3.1 Number of times the haplotype was observed within each population 
3.4.4.3.2 The profile probability (the frequency upper bound) 

3.4.5 The reason for inconclusive results must be clearly stated.  
3.4.6 Assumptions must be stated, e.g., mutations in paternity analysis, presumed biological 

relationships, or using an intimate evidentiary item of evidence as a known source of 
DNA in the absence of a known sample. 

3.4.7 If data is observed below analytical threshold that is impacting the number of 
contributors, its presence must be noted in the report. 

 
3.5 The analyst may include the DNA profile(s) in the report in the form of a table.   

 
When a foreign profile is deduced from an intimate sample it may be included as a separate 
line in the allele table.  When a foreign profile is detected as part of a deconvolution, for 
example as a major or minor component, it is not necessary to include that profile on a 
separate line in the allele table. 
 
 

http://usystrdatabase.org/
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If a locus is inconclusive or not responsive to testing, the profile at that locus shall not be 
reported and shall not be included in calculations of statistical significance estimations.  
Inconclusive alleles may not necessarily preclude the use of an entire locus (e.g., in instances of 
inconclusive minor activity). 
 
 

The wording of the conclusions in reports depends on the specific nature of the results.  Reference to 
previous analysis, whether screening or DNA, must be made in each report.  When comparing new data 
to previously reported data, the report must indicate the initial data’s report date and case #, should it 
be different.    
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